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About This Manual

Introduction to the Manuals
The following manuals are supplied with your Epson printer. As well as the manuals, check the various types of
help information available from the printer itself or from the Epson software applications.

❏ Important Safety Instructions (paper manual)
Provides you with instructions to ensure the safe use of this printer.

❏ Start Here (paper manual)
Provides you with information on setting up the printer and installing the software.

❏ User's Guide (digital manual)
This manual. Provides overall information and instructions on using the printer and on solving problems.

❏ Administrator's Guide (digital manual)
Provides network administrators with information on management and printer settings.

You can obtain the latest versions of the above manuals with the following methods.

❏ Paper manual
Visit the Epson Europe support website at http://www.epson.eu/Support, or the Epson worldwide support
website at http://support.epson.net/.

❏ Digital manual
Start EPSON Software Updater on your computer. EPSON Software Updater checks for available updates of
Epson software applications and the digital manuals, and allows you to download the latest ones.

Related Information

& “Software Update Tools (EPSON Software Updater)” on page 85

Using the Manual to Search for Information
The PDF manual allows you to search for information you are looking for by keyword, or jump directly to specific
sections using the bookmarks. You can also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.
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Searching by keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you want to find in the search window,
and then click Search. Hits are displayed as a list. Click one of the displayed hits to jump to that page.

Jumping directly from bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in that section. To return to the previous
page, perform the following operation on your keyboard.

❏ Windows: Hold down Alt, and then press ←.

❏ Mac OS: Hold down the command key, and then press ←.

Printing only the pages you need

You can extract and print only the pages you need. Click Print in the File menu, and then specify the pages you
want to print in Pages in Pages to Print.

❏ To specify a series of pages, enter a hyphen between the start page and the end page.
Example: 20-25

❏ To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

User's Guide
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Marks and Symbols

!Caution:

Instructions that must be followed carefully to avoid bodily injury.

c
Important:

Instructions that must be observed to avoid damage to your equipment.

Note:
Provides complementary and reference information.

& Related Information

Links to related sections.

Descriptions Used in this Manual
❏ Screenshots of the printer driver screens are from Windows 10 or macOS High Sierra. The content displayed on

the screens varies depending on the model and situation.

❏ Illustrations of the printer used in this manual are examples only. Although there may be slight differences
depending on the model, the method of operation is the same.

❏ Some of the menu items on the LCD screen vary depending on the model and settings.

Operating System References

Windows

In this manual, terms such as "Windows 10", "Windows 8.1", "Windows 8", "Windows 7", "Windows Vista",
"Windows XP", "Windows Server 2016", "Windows Server 2012 R2", "Windows Server 2012", "Windows Server 2008
R2", "Windows Server 2008", "Windows Server 2003 R2", and "Windows Server 2003" refer to the following
operating systems. Additionally, "Windows" is used to refer to all versions.

❏ Microsoft® Windows® 10 operating system

❏ Microsoft® Windows® 8.1 operating system

❏ Microsoft® Windows® 8 operating system

❏ Microsoft® Windows® 7 operating system

❏ Microsoft® Windows Vista® operating system

❏ Microsoft® Windows® XP operating system

❏ Microsoft® Windows® XP Professional x64 Edition operating system

❏ Microsoft® Windows Server® 2016 operating system

❏ Microsoft® Windows Server® 2012 R2 operating system

❏ Microsoft® Windows Server® 2012 operating system
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❏ Microsoft® Windows Server® 2008 R2 operating system

❏ Microsoft® Windows Server® 2008 operating system

❏ Microsoft® Windows Server® 2003 R2 operating system

❏ Microsoft® Windows Server® 2003 operating system

Mac OS

In this manual, "Mac OS" is used to refer to macOS High Sierra, macOS Sierra, OS X El Capitan, OS X Yosemite,
OS X Mavericks, OS X Mountain Lion, Mac OS X v10.7.x, and Mac OS X v10.6.8.
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Important Instructions

Safety Instructions
Read and follow these instructions to ensure safe use of this printer. Make sure you keep this manual for future
reference. Also, be sure to follow all warnings and instructions marked on the printer.

❏ Some of the symbols used on your printer are to ensure safety and proper use of the printer. Visit the following
Web site to learn the meaning of the symbols.
http://support.epson.net/symbols

❏ Use only the power cord supplied with the printer and do not use the cord with any other equipment. Use of
other cords with this printer or the use of the supplied power cord with other equipment may result in fire or
electric shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, or options by yourself, except
as specifically explained in the printer's manuals.

❏ Unplug the printer and refer servicing to qualified service personnel under the following conditions:
The power cord or plug is damaged; liquid has entered the printer; the printer has been dropped or the casing
damaged; the printer does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

❏ Place the printer near a wall outlet where the plug can be easily unplugged.

❏ Do not place or store the printer outdoors, near excessive dirt or dust, water, heat sources, or in locations
subject to shocks, vibrations, high temperature or humidity.

❏ Take care not to spill liquid on the printer and not to handle the printer with wet hands.

❏ Keep the printer at least 22 cm away from cardiac pacemakers. Radio waves from this printer may adversely
affect the operation of cardiac pacemakers.

❏ If the LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

❏ The printer is heavy and should not be lifted or carried by less than two people. When lifting the printer, two or
more people should assume the correct positions as shown below.

User's Guide
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❏ Be careful when you handle used ink supply units, as there may be some ink around the ink supply port.

❏ If ink gets on your skin, wash the area thoroughly with soap and water.

❏ If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after
a thorough flushing, see a doctor immediately.

❏ If ink gets into your mouth, see a doctor right away.

❏ Do not disassemble the ink supply unit and the maintenance box; otherwise ink may get into your eyes or on
your skin.

❏ Do not shake ink supply units too vigorously; otherwise ink may leak from the ink supply units.

❏ Keep ink supply units and maintenance box out of the reach of children.

Printer Advisories and Warnings
Read and follow these instructions to avoid damaging the printer or your property. Make sure you keep this
manual for future reference.

Advisories and Warnings for Setting Up the Printer
❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer's label.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

❏ The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over.
Be particularly careful to keep all the power-supply cords straight at the ends and the points where they enter
and leave the transformer.

❏ If you use an extension cord with the printer, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord's ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.

❏ If you plan to use the printer in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the printer.

❏ When connecting the printer to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation
may damage both devices connected by the cable.

❏ Place the printer on a flat, stable surface that extends beyond the base of the printer in all directions. The printer
will not operate properly if it is tilted at an angle.

❏ Allow space above the printer so that you can fully raise the printer cover.

❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the printer away from direct
sunlight, strong light, or heat sources.
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Advisories and Warnings for Using the Printer
❏ Do not insert objects through the slots in the printer.

❏ Do not put your hand inside the printer during printing.

❏ Do not touch the white flat cable inside the printer.

❏ Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may cause fire.

❏ Do not move the print head by hand; otherwise, you may damage the printer.

❏ Always turn the printer off using the P button. Do not unplug the printer or turn off the power at the outlet
until the P light stops flashing.

❏ If you are not going to use the printer for a long period, be sure to unplug the power cord from the electrical
outlet.

Advisories and Warnings for Transporting or Storing the Printer
❏ When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;

otherwise ink may leak.

❏ Before transporting the printer, make sure that the print head is in the home (far right) position, and the ink
supply unit is installed.

Advisories and Warnings for Using the Printer with a Wireless
Connection
❏ Radio waves from this printer may negatively affect the operation of medical electronic equipment, causing

them to malfunction. When using this printer inside medical facilities or near medical equipment, follow
directions from the authorized personnel representing the medical facilities, and follow all posted warnings and
directions on the medical equipment.

❏ Radio waves from this printer may negatively affect the operation of automatically controlled devices such as
automatic doors or fire alarms, and could lead to accidents due to malfunction. When using this printer near
automatically controlled devices, follow all posted warnings and directions on these devices.

Advisories and Warnings for Using the LCD Screen
❏ The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven

brightness. These are normal and do not indicate that it is damaged in any way.

❏ Only use a dry, soft cloth for cleaning. Do not use liquid or chemical cleaners.

❏ The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the
screen's surface chips or cracks, and do not touch or attempt to remove the broken pieces.

Protecting Your Personal Information
When you give the printer to someone else or dispose of it, erase all the personal information stored in the printer's
memory by selecting the menus on the control panel as described below.

User's Guide

Important Instructions

11



Settings > General Settings > System Administration > Restore Default Settings > All Settings
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Printer Basics

Part Names and Functions

A Control panel Operates the printer.

You can change the angle of the control panel.

B Paper cassette (C1) Loads paper.

A Paper feed slot Load one sheet of paper at a time by hand.

B Edge guides Feeds the paper straight into the printer. Slide to the edges of the
paper.

C Output tray Holds the ejected paper.

D Edge guides Feeds the paper straight into the printer. Slide to the edges of the
paper.
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E Paper cassette Loads paper.

A Printer cover (J) Open when removing jammed paper inside the printer.

B Print head Fires ink.

C Ink supply unit tray Sets an ink supply unit.

D Front cover (A) Open when replacing ink supply unit.

E Front cover lock Locks the front cover.
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A LAN port Connects a LAN cable.

B USB port Connects a USB cable.

C Service USB port USB port for future use.

Do not remove the sticker.

D AC inlet Connects the power cord.

E Rear Cover (D) Open when removing jammed paper.

F Maintenance box cover (H) Open when replacing the maintenance box.

Control Panel

A Pass a smart device over this mark to print from the smart device directly.

B Turns the printer on or off.

Unplug the power cord after checking that the power light is off.

C Displays the home screen.

D Displays the Paper Setting screen. You can select the paper size and paper type settings for the paper cassette.

E Stops the current operation.

F Applies to a variety of functions depending on the situation.

G Press l, u, r and d to select the items. Press OK to confirm your selection or run the selected feature.

H Returns to the previous screen.

I Flashes when the printer is processing data.

It turns on when there are queued jobs.

J Flashes or turns on when an error occurs.
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Basic Screen Configuration

A Indicates items that have been setup for the printer as icons. Select the icon to check the current settings or access
each setting menu.

This action bar is displayed on the home screen only.

B Displays each mode.

C Available buttons are displayed.

Icons displayed in the LCD Screen
The following icons are displayed on the LCD screen depending on the printer's status.

Displays the Supply Status screen.

You can check the approximate ink levels and the approximate service life of the maintenance box.

Indicates the network connection status.

Select the icon to check and change the current settings. This is the shortcut for the following menu.

Settings > General Settings > Network Settings > Wi-Fi Setup

The printer is not connected to a wired (Ethernet) network or unset it.

The printer is connected to a wired (Ethernet) network.

The printer is not connected to a wireless (Wi-Fi) network.

The printer is searching for SSID, unset IP address, or having a problem with a wireless (Wi-Fi)
network.

The printer is connected to a wireless (Wi-Fi) network.

The number of bars indicates the signal strength of the connection. The more bars there are, the
stronger the connection.

The printer is not connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP) mode.

The printer is connected to a wireless (Wi-Fi) network in Wi-Fi Direct (Simple AP) mode.
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Indicates whether or not Quiet Mode is set for the printer. When this feature is enabled, the noise made
by printer operations is reduced, but print speed may slow down. However, noises may not be reduced
depending on the selected paper type and print quality.

Displays the Help screen. You can view the operating instructions or the solutions to problems.

Indicates that there is additional information. Select the icon to display the message.

Indicates a problem with the items. Select the icon to check how to solve the problem.

Basic Operations

Move the focus using the u d l r buttons to select the items, and then press the OK button to confirm your
selection or run the selected feature.

Move the focus to the setting item using the u d l r buttons, and then press the OK button to switch the item
on or off.
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To enter the value, name, address, and so on, move the focus to the input field using the u d l r buttons, and
then press the OK button to display the on-screen keyboard.

Entering Characters

On-screen Keyboard

You can enter characters and symbols by using on-screen keyboard when you make network settings and so on.

Note:
Available icons vary depending on the setting item.

A Indicates the character count.

B Moves the cursor to the input position.

C Switches between upper case and lower case or numbers and symbols.

You can also switch them by using the  button.

D Switches the character type. You can enter alphanumerics and symbols.

You can also switch them by using the  button.

E Changes the keyboard layout.

F Enters frequently used email domain addresses or URLs by simply selecting the item.
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G Enters a space.

H Confirms the entered characters.

I Deletes a character to the left.

Viewing Animations
You can view animations of operating instructions such as loading paper or removing jammed paper on the LCD
screen.

❏ Select  on the home screen: Displays the help screen. Select How To and then select the items that you want
to view.

❏ Select How To at the bottom of the operation screen: Displays the context-sensitive animation.

A Indicates the total number of steps and the current step number.

In the example above, it shows step 2 from 4 steps.

B Press l button to return to the previous step.

C Indicates your progress through the current step. The animation repeats when the progress bar reaches the end.

D Press r button to move to the next step.
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Preparing the Printer

Loading Papers

Available Paper and Capacities
Epson recommends using genuine Epson paper to ensure high-quality printouts.

Genuine Epson Paper

Note:
Genuine Epson paper is not available when printing with the Epson universal printer driver.

Media Name Size Loading Capacity (Sheets) 2-Sided
Printing*

Paper Cassette Paper Feed Slot

Epson Bright White Ink
Jet Paper

A4 200 1 Auto, Manual

Epson Matte Paper-
Heavyweight

A4 50 1 –

Epson Double-Sided
Matte Paper

A4 50 1 –

Epson Photo Quality Ink
Jet Paper

A4 80 1 –

* Only use the paper cassette to print 2-sided print jobs manually.

Note:
❏ The availability of paper varies by location. For the latest information on paper available in your area, contact Epson

support.

❏ When printing on genuine Epson paper at a user defined size, only Standard or Normal print quality settings are
available. Although some printer drivers allow you to select a better print quality, the printouts are printed using
Standard or Normal.

Commercially Available Paper

Note:
Half letter, SP1 (210×270 mm), SP2 (210×149 mm), SP3 (100×170 mm), SP4 (130×182 mm), SP5 (192×132 mm) and 16K
(195×270 mm) sizes are not available when printing with the PostScript printer driver.
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Media Name Size Loading Capacity (Sheets or
Envelopes)

2-Sided
Printing*1

Paper Cassette Paper
Feed Slot

Plain paper, Copy
paper

Letterhead

Recycled paper

Color paper

Preprinted paper

High quality plain
paper

Letter, A4, Executive*2, B5, A5, SP1
(210×270 mm)*2, 16K (195×270 mm)

Up to the line indicated

by the  symbol
on the edge guide.

1 Auto,
Manual

Legal, 8.5×13 in, Half letter*2, A6, B6, SP2
(210×149 mm)*2

Up to the line indicated

by the  symbol
on the edge guide.

1 Manual

SP3 (100×170 mm)*2, SP4 (130×182 mm)*2 Up to the line indicated

by the  symbol
on the edge guide.

1 Manual

SP5 (192×132 mm)*2,

User Defined*2 (mm)

89×127 to 215.9×148

89×148 to 100×355.6

Up to the line indicated

by the  symbol
on the edge guide.

– Manual

User Defined*2 (mm)

100×148 to 215.9×355.6

Up to the line indicated

by the symbol on
the edge guide.

1 Auto*5,
Manual

User Defined*2 (mm)

100×355.6 to 215.9×6000

– 1 Manual

Thick paper

(For the paper
cassette: 91 to
160 g/m2.

For the paper
feed slot: 91 to
180 g/m2.)

Letter, A4, Executive*2 , B5, A5, SP1
(210×270 mm)*2, 16K (195×270 mm)

90 1 Auto*4,
Manual

Legal, 8.5×13 in, Half letter*2, A6, B6, SP2
(210×149 mm)*2

90 1 Manual

SP3 (100×170 mm)*2, SP4 (130×182 mm)*2 90 1 Manual

SP5 (192×132 mm)*2,

User Defined*2 (mm)

89×127 to 215.9×148

89×148 to 100×355.6

90 – Manual

User Defined*2 (mm)

100×148 to 215.9×355.6

90 1 Auto*4*5,
Manual

User Defined*2 (mm)

64×355.6 to 215.9×1117.6

– 1 Manual

Envelope Envelope #10, Envelope DL, Envelope C6 10 1*3 –

Envelope C4 – 1 –

*1 Only use the paper cassette to print 2-sided print jobs manually.
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*2 Only printing from computer is available.

*3 Use the paper cassette if the envelope is wrinkled when loading from the paper feed slot.

*4 When printing 2-sided print jobs automatically from the paper feed slot, the weight of the paper can be up to 160 g/m2.

*5 For automatic 2-sided printing, 148×210 to 215.9×297 mm size paper is available.

Related Information

& “Part Names and Functions” on page 13

Paper Handling Precautions

❏ Read the instruction sheets supplied with the paper.

❏ Fan and align the edges of the paper before loading. Do not fan or curl photo paper. Doing so may damage the
printable side.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled
paper may cause paper jams and smears on the printout.

❏ Do not use paper that is wavy, torn, cut, folded, damp, too thick, too thin, or paper that has stickers stuck to it.
Using these types of paper causes paper jams and smears on the printout.

❏ Make sure you are using long-grain paper. If you are not sure what type of paper you are using, check the paper
packaging or contact the manufacturer to confirm the paper specifications.

Related Information

& “Printer Specifications” on page 109
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Loading Paper in the Paper Cassette

1. Check that the printer is not operating, and then pull out the paper cassette.

2. Slide the front edge guide to its maximum position, and then slide the side edge guides to adjust to the paper
size you want to use.
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Note:
When using paper larger than A4 size, extend the paper cassette.

3. Load paper with the printable side facing down, and then slide the front edge guide to the edge of the paper.

c
Important:

Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load

above the line indicated by the  symbol inside the edge guide. For thick paper, do not load above the line

indicated by the  symbol inside the edge guide.

4. Insert the paper cassette all the way.

5. On the control panel, set the size and type of the paper you loaded in the paper cassette.

Note:
You can also display the paper size and paper type settings screen by pressing the  button on the control panel.

6. Slide out the output tray when loading paper longer than A4 size.
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Related Information

& “Paper Handling Precautions” on page 22
& “Available Paper and Capacities” on page 20
& “List of Paper Type” on page 28
& “Loading Envelopes and Precautions” on page 26

Loading Paper in the Paper Feed Slot

1. Slide the edge guides.

2. Load paper at the center of the paper feed slot with the printable side facing down.

c
Important:

Load paper short edge first. However, when you have set the long edge as the width of the user defined size,
load paper long edge first.

Pre-punched paper

Note:
You can use pre-punched paper under the following conditions. Automatic 2-sided printing is not available for
prepunched paper.

❏ Available size: A4, B5, A5, A6, Letter, Legal

❏ Binding holes: Do not load paper with the binding holes at the top or the bottom.
Adjust the print position of your file to avoid printing over the holes.

❏ Paper setting: Select Letterhead or Preprinted as the paper type setting.
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3. Slide the edge guides to the edges of the paper.

4. Slide out the output tray when loading paper longer than A4 size.

Related Information

& “Paper Handling Precautions” on page 22
& “Available Paper and Capacities” on page 20
& “List of Paper Type” on page 28
& “Loading Envelopes and Precautions” on page 26
& “Loading Long Papers” on page 27

Loading Envelopes and Precautions
Load envelope in the center of the paper feed slot short edge first with the flap facing up, and slide the edge guides
to the edges of the envelope.
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Load envelopes in the paper cassettewith the flap facing up, and then slide the edge guides to the edges of the
envelopes.

❏ Fan and align the edges of the envelopes before loading. When the stacked envelopes are puffed up with air,
press them down to flatten them before loading.

❏ Do not use envelopes that are curled or folded. Using these envelopes causes paper jams and smears on the
printout.

❏ Do not use envelopes with adhesive surfaces on the flaps or window envelopes.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25

Loading Long Papers
Only use the paper feed slot to load long paper. Before loading paper in the printer, cut the paper to the size you
want to print. Select User-Defined as the paper size setting.

❏ Make sure the end of the paper is cut perpendicularly. A diagonal cut may cause paper feed problems.

❏ Long paper cannot be held in the output tray. Prepare a box and so on to make sure that paper does not fall on
the floor.

❏ Do not touch paper that is being fed or ejected. It could injure your hand or cause print quality to decline.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Feed Slot” on page 25
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List of Paper Type
To obtain optimum printing results, select the paper type that suits the paper.

Media Name Media Type

Control Panel Printer Driver PostScript Printer
Driver

Epson Universal Printer
Driver

Epson Bright White
Ink Jet Paper

Plain paper Plain paper Plain Plain

Epson Matte Paper-
Heavyweight

Epson Double-Sided
Matte Paper

Matte Epson Matte Epson Matte -

Epson Photo Quality
Ink Jet Paper

Matte Epson Matte Epson Matte -

Menu Options for Settings
Select Settings on the home screen of the printer to make various settings.

Menu Options for General Settings
Select the menus on the control panel as described below.

Settings > General Settings

Basic Settings

Select the menus on the control panel as described below.

Settings > General Settings > Basic Settings

You cannot change settings that have been locked by your administrator.

LCD Brightness:

Adjust the brightness of the LCD screen.

Sleep Timer:

Adjust the time period to enter a sleep mode (energy saving mode) when the printer has not
performed any operations. The LCD screen turns black when the setting time passes.

Power Off Settings:

Your product may have this feature or the Power Off Timer feature depending on the location of
purchase.
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❏ Power Off If Inactive
Select this setting to turn the printer off automatically if it is not used for a specified period of
time. Any increase will affect the product’s energy efficiency. Please consider the environment
before making any change.

❏ Power Off If Disconnected
Select this setting to turn the printer off after 30 minutes when all network ports including the
LINE port are disconnected. This feature may not be available depending on your region.

Power Off Timer:

Your product may have this feature or the Power Off Settings feature depending on the location of
purchase.

Select this setting to turn the printer off automatically when it is not used for a specified period of
time. You can adjust the time before power management is applied. Any increase will affect the
product’s energy efficiency. Please consider the environment before making any change.

Date/Time Settings:

❏ Date/Time
Enter the current date and time.

❏ Daylight Saving Time
Select the summer time setting that applies to your area.

❏ Time Difference
Enter the time difference between your local time and UTC (Coordinated Universal Time).

Language:

Select the language used on the LCD screen.

Operation Time Out:

Select On to return to the initial screen when no operations have been performed for the specified
time. When user restrictions have been applied and no operations are performed for the specified
time, you are logged out and returned to the initial screen.

Keyboard:

Change the layout of the keyboard on the LCD screen.

Related Information

& “Saving Power” on page 37
& “Entering Characters” on page 18

Printer Settings

Select the menus on the control panel as described below.

Settings > General Settings > Printer Settings

You cannot change settings that have been locked by your administrator.
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Paper Source Settings:

Paper Setting:

Select the paper size and paper type you loaded in the paper sources.

A4/Letter Auto Switching:

Select On to feed paper from the paper source set as A4 size when there is no paper source set
as Letter, or feed from the paper source set as Letter size when there is no paper source set as
A4.

Error Notice:

Select On to display an error message when the selected paper size or type does not match the
loaded paper.

Paper Setup Auto Display:

Select On to display the Paper Setting screen when loading paper in the paper source. If you
disable this feature, you cannot print from an iPhone or iPad using AirPrint.

Printing Language:

Select the printing language for the USB interface or the network interface.

Universal Print Settings:

These print settings are applied when you print by an external device without using the printer driver.

Paper Feed Slot Priority:

Select On to give printing priority to paper loaded in the paper feed slot.

Top Offset:

Adjust the top margin of the paper.

Left Offset:

Adjust the left margin of the paper.

Top Offset in Back:

Adjust the top margin for the back of the page when performing 2-sided printing.

Left Offset in Back:

Adjust the left margin for the back margin of the page when performing 2-sided printing.

Check Paper Width:

Select On to check the paper width before printing. This prevents printing beyond the edges of
the paper when the paper size setting is incorrect, but this may lower the print speed.

Skip Blank Page:

Skips blank pages in the print data automatically.

PDL Print Configuration:

Select the PDL Print Configuration options you want to use for PCL or PostScript printing.
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Common Settings:

❏ Paper Size
Select the default paper size for PCL or PostScript printing.

❏ Paper Type
Select the default paper type for PCL or PostScript printing.

❏ Orientation
Select the default orientation for PCL or PostScript printing.

❏ Quality
Select the print quality for PCL or PostScript printing.

❏ Ink Save Mode
Select On to save ink by reducing the print density.

❏ Print Order
Last Page on Top:
Starts printing from the first page of a file.
First Page on Top:
Starts printing from the last page of a file.

❏ Number of Copies
Set the number of copies to print.

❏ Binding Margin
Select the binding position.

❏ Auto Paper Ejection
Select On to eject paper automatically when printing is stopped during a print job.

❏ 2-Sided Printing
Select On to perform 2-sided printing.

PCL Menu:

❏ Font Source
Resident
Select to use a font preinstalled on the printer.
Download
Select to use a font you have downloaded.

❏ Font Number
Select the default font number for the default font source. The available number
varies depending on the settings you made.

❏ Pitch
Set the default font pitch if the font is scalable and of fixed-pitch. You can select from
0.44 to 99.99 cpi (characters per inch), in 0.01 increments.
This item may not appear depending on the font source or font number settings.

❏ Height
Set the default font height if the font is scalable and proportional. You can select from
4.00 to 999.75 points, in 0.25 increments.
This item may not appear depending on the font source or font number settings.

User's Guide

Preparing the Printer

31



❏ Symbol Set
Select the default symbol set. If the font that you selected in the font source and the
font number setting is not available in the new symbol set setting, the font source and
the font number settings are automatically replaced with the default value, IBM-US.

❏ Form
Set the number of lines for the selected paper size and orientation. This also causes a
line spacing (VMI) change, and the new VMI value is stored in the printer. This
means that later changes in the page size or orientation settings cause changes in the
Form value based on the stored VMI.

❏ CR Function
Select the line feed command when printing with a driver from a specific operating
system.

❏ LF Function
Select the line feed command when printing with a driver from a specific operating
system.

❏ Paper Source Assign
Set the assignment for the paper source select command. When 4 is selected, the
commands are set as compatible with the HP LaserJet 4. When 4K is selected, the
commands are set as compatible with the HP LaserJet 4000, 5000, and 8000. When
5S is selected, the commands are set as compatible with the HP LaserJet 5S.

PS3 Menu:

❏ Error Sheet
Select On to print a sheet showing the status when an error occurs during PostScript
or PDF printing.

❏ Binary
Select On when printing data that contains binary images. The application may send
the binary data even if the printer driver setting is set to ASCII, but you can print the
data when this feature is enabled.

❏ PDF Page Size
Select the paper size when printing a PDF file. If Auto is selected, the paper size is
determined based on the size of the first page.

Auto Error Solver:

Select an action to perform when a 2-sided printing error or a memory full error occurs.

❏ On
Displays a warning and prints in single-sided mode when a 2-sided printing error occurs, or prints
only what the printer could process when a memory full error occurs.

❏ Off
Displays an error message and cancels printing.

Thick Paper:

Select On to prevent ink from smearing on your printouts, however, this may lower the print speed.
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Quiet Mode:

Select On to reduce noise during printing, however, this may lower the print speed. Depending on
the paper type and print quality settings you selected, there may be no difference in the printer's noise
level.

Ink Drying Time:

Select the ink drying time you want to use when performing 2-sided printing. The printer prints the
other side after printing one side. If your printout is smeared, increase the time setting.

PC Connection via USB:

Select Enable to allow a computer to access the printer when connected by USB. When Disable is
selected, printing that is not sent over a network connection is restricted.

USB I/F Timeout Setting:

Specify the length of time in seconds that must elapse before ending USB communication with a
computer after the printer receives a print job from a PostScript printer driver or PCL printer driver.
If the job ending is not clearly defined from a PostScript printer driver or PCL printer driver, it can
cause endless USB communication. When this occurs, the printer ends communication after the
specified time has elapsed. Enter 0 (zero) if you do not want to end communication.

Related Information

& “Loading Papers” on page 20

Network Settings

Select the menus on the control panel as described below.

Settings > General Settings > Network Settings

You cannot change settings that have been locked by your administrator.

Wi-Fi Setup:

Set up or change wireless network settings. Choose the connection method from the following and then
follow the instructions on the LCD panel.

❏ Router

❏ Wi-Fi Direct

Wired LAN Setup:

Set up or change a network connection that uses a LAN cable and router. When this is being used, Wi-
Fi connections are disabled.

Network Status:

Displays or prints the current network settings.

❏ Wired LAN/Wi-Fi Status

❏ Wi-Fi Direct Status

❏ Print Status Sheet

User's Guide

Preparing the Printer

33



Connection Check:

Checks the current network connection and prints a report. If there are any problems with the
connection, see the report to solve the problem.

Advanced:

Make the following detailed settings.

❏ Device Name

❏ TCP/IP

❏ Proxy Server

❏ IPv6 Address

❏ NFC

❏ Link Speed & Duplex

❏ Redirect HTTP to HTTPS

❏ Disable IPsec/IP Filtering

❏ Disable IEEE802.1X

Web Service Settings

Select the menus on the control panel as described below.

Settings > General Settings > Web Service Settings

You cannot change settings that have been locked by your administrator.

Epson Connect Services:

Displays whether the printer is registered and connected to Epson Connect.

You can register to the service by selecting Register and follow the instructions.

When you have registered, you can change the following settings.

❏ Suspend/Resume

❏ Unregister

For details, see the following web site.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Google Cloud Print Services:

Displays whether the printer is registered and connected to Google Cloud Print services.

When you have registered, you can change the following settings.

❏ Enable/Disable

❏ Unregister

For details on registering to Google Cloud Print services, see the following web site.

https://www.epsonconnect.com/
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System Administration

Select the menu on the control panel as described below.

Settings > General Settings > System Administration

Administrators use this feature. See the Administrator's Guide for details.

Menu Options for Print Counter
Select the menus on the control panel as described below.

Settings > Print Counter

Displays the total number of prints from the time you purchased the printer.

Menu Options for Supply Status
Select the menu on the control panel as described below.

Settings > Supply Status

Displays the approximate level of the ink and service life of the maintenance box.

When  is displayed, ink is running low or the maintenance box is nearly full. When  is displayed, you need
to replace the item as ink is expended or the maintenance box is full.

Menu Options for Maintenance
Select the menus on the control panel as described below.

Settings > Maintenance

Print Quality Adjustment:

Select this feature if there are any problems with your print outs. You can check for clogged nozzles
and clean the print head if necessary, and then adjust some parameters to improve print quality.

Print Head Nozzle Check:

Select this feature to check if the print head nozzles are clogged. The printer prints a nozzle check
pattern.

Print Head Cleaning:

Select this feature to clean clogged nozzles in the print head.

Print Head Alignment:

Select this feature to adjust the print head to improve print quality.
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❏ Ruled Line Alignment
Select this feature to align vertical lines.

❏ Horizontal Alignment
Select this feature if horizontal banding appears at regular intervals in your printouts.

Paper Guide Cleaning:

Select this feature if there are ink stains on the internal rollers. The printer feeds paper to clean the
internal rollers.

Periodic Cleaning:

The printer automatically performs Print Head Nozzle Check and Print Head Cleaning based on
the specific period of time. Select On to maintain premium print quality. Under the following
conditions, perform Print Head Nozzle Check and Print Head Cleaning yourself.

❏ Printout problems

❏ When Off is selected for Periodic Cleaning

❏ When printing at high quality, such as photos

❏ When the Print Head Cleaning message is displayed on the LCD screen

Related Information

& “Adjusting the Print Quality” on page 99
& “Checking and Cleaning the Print Head” on page 79
& “Aligning the Print Head” on page 80
& “Cleaning the Paper Path for Ink Smears” on page 82

Menu Options for Language
Select the menus on the control panel as described below.

Settings > Language

Select the language used on the LCD screen.

Menu Options for Printer Status/Print
Select the menus on the control panel as described below.

Settings > Printer Status/Print

Print Status Sheet:

Configuration Status Sheet:

Print information sheets showing the current printer status and settings.

Supply Status Sheet:

Print information sheets showing the status of consumables.
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Usage History Sheet:

Print information sheets showing the usage history of the printer.

PS3 Font List:

Print a list of fonts that are available for a PostScript printer.

PCL Font List:

Print a list of fonts that are available for a PCL printer.

Network:

Displays the current network settings.

Menu Options for Authentication Device Status
Select the menus on the control panel as described below.

Settings > Authentication Device Status

Displays the status of the authentication device.

Menu Options for Epson Open Platform Information
Select the menus on the control panel as described below.

Settings > Epson Open Platform Information

Displays the status of the Epson Open Platform.

Saving Power
The printer enters sleep mode or turns off automatically if no operations are performed for a set period. You can
adjust the time before power management is applied. Any increase will affect the product's energy efficiency. Please
consider the environment before making any change.

Depending on the location of purchase, the printer may have a feature that turns it off automatically if it is not
connected to the network for 30 minutes.

Saving Power - Control Panel

1. Select Settings on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

2. Select General Settings > Basic Settings.
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3. Do one of the following.

❏ Select Sleep Timer or Power Off Settings > Power Off If Inactive or Power Off If Disconnected, and then
make settings.

❏ Select Sleep Timer or Power Off Timer, and then make settings.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.
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Printing

Printing from the Printer Driver on Windows
If you cannot change some of the printer driver settings, they may have been restricted by the administrator.
Contact your printer administrator for assistance.

Accessing the Printer Driver
When accessing the printer driver from the computer's control panel, the settings are applied to all of the
applications.

Accessing the printer driver from the control panel

❏ Windows 10/Windows Server 2016
Click on the start button, and then select Windows System > Control Panel > View devices and printers in
Hardware and Sound. Right-click on your printer, or press and hold it and then select Printing preferences.

❏ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound. Right-click
on your printer, or press and hold it and then select Printing preferences.

❏ Windows 7/Windows Server 2008 R2
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound. Right-
click on your printer and select Printing preferences.

❏ Windows Vista/Windows Server 2008
Click the start button, and select Control Panel > Printers in Hardware and Sound. Right-click on your printer
and select Select printing preferences.

❏ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click the start button, and select Control Panel > Printers and Other Hardware > Printers and Faxes. Right-
click on your printer and select Printing preferences.

Accessing the printer driver from the printer icon on the task bar

The printer icon on the desktop task bar is a shortcut icon allowing you to quickly access the printer driver.

If you click the printer icon and select Printer Settings, you can access the same printer settings window as the one
displayed from the control panel. If you double-click this icon, you can check the status of the printer.

Note:
If the printer icon is not displayed on the task bar, access the printer driver window, click Monitoring Preferences on the
Maintenance tab, and then select Register the shortcut icon to the taskbar.

Printing Basics
Note:
Operations may differ depending on the application. See the application's help for details.
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1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.

2. Select Print or Page Setup from the File menu.

3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

5. Change the settings as necessary.

See the menu options for the printer driver for details.

Note:
❏ You can also see the online help for explanations of the setting items. Right-clicking an item displays Help.

❏ When you select Print Preview, you can see a preview of your document before printing.

6. Click OK to close the printer driver window.

7. Click Print.

Note:
When you select Print Preview, a preview window is displayed. To change the settings, click Cancel, and then repeat
the procedure from step 2.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “List of Paper Type” on page 28
& “Main Tab” on page 56
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Printing on 2-Sides
You can print on both sides of the paper. You can also print a booklet that can be created by re-ordering the pages
and folding the printout.

Note:
❏ You can use automatic and manual 2-sided printing. During manual 2-sided printing, flip the paper over to print on the

other side when the printer has finished printing the first side.

❏ If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

❏ Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

& “Available Paper and Capacities” on page 20

Print Settings

Manual 2-sided printing is available when EPSON Status Monitor 3 is enabled. However, it may not be available
when the printer is accessed over a network or is used as a shared printer.

Note:
To enable EPSON Status Monitor 3, click Extended Settings on the Maintenance tab, and then select Enable EPSON
Status Monitor 3.

1. On the printer driver's Main tab, select an option from 2-Sided Printing.

2. Click Settings, make the appropriate settings, and then click OK.

Make settings for Print Density if necessary. This setting is not available when you select manual 2-sided
printing.

Note:
❏ To print a folded booklet, select Booklet.

❏ When setting Print Density, you can adjust print density according to the document type.

❏ Printing may be slow depending on the combination of options selected for Select Document Type in the Print
Density Adjustment window and for Quality on the Main tab.
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3. Click Print.

For manual 2-sided printing, when the first side has finished printing, a pop-up window is displayed on the
computer. Follow the on-screen instructions.

Related Information

& “Printing Basics” on page 39
& “Main Tab” on page 56

Printing Several Pages on One Sheet
You can print two or four pages of data on a single sheet of paper.

Print Settings

On the printer driver's Main tab, select 2-Up or 4-Up as the Multi-Page setting.

Related Information

& “Printing Basics” on page 39
& “Main Tab” on page 56
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Printing and Stacking in Page Order (Reverse Order Printing)
You can print from the last page so that the documents are stacked in page order.

Print Settings

On the printer driver's Main tab, select Reverse Order.

Related Information

& “Printing Basics” on page 39
& “Main Tab” on page 56

Printing a Reduced or Enlarged Document
You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

Print Settings

On the printer driver's More Options tab, select the document size from the Document Size setting. Select the
paper size you want to print on from the Output Paper setting. Select Reduce/Enlarge Document, and then select
Fit to Page or Zoom to. When you select Zoom to, enter a percentage.

Select Center to print the images in the center of the page.
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Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56

Printing One Image on Multiple Sheets for Enlargement (Creating a
Poster)
This feature allows you to print one image on multiple sheets of paper. You can create a larger poster by taping
them together.

Print Settings

On the printer driver's Main tab, select 2x1 Poster, 2x2 Poster, 3x3 Poster, or 4x4 Poster as the Multi-Page
setting. If you click Settings, you can select the panels that you do not want to print. You can also select the cutting
guide options.

Related Information

& “Printing Basics” on page 39
& “Main Tab” on page 56

Making Posters Using Overlapping Alignment Marks

Here is an example of how to make a poster when 2x2 Poster is selected, and Overlapping Alignment Marks is
selected in Print Cutting Guides.
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The actual guides are printed in monochrome, but for this explanation they are shown as blue and red lines.

1. Prepare Sheet 1 and Sheet 2. Cut off the margins of Sheet 1 along the vertical blue line through the center of
the top and bottom cross marks.
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2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily tape the two sheets
together from the back.

3. Cut the taped sheets in two along the vertical red line through the alignment markers (this time, the line to the
left of the cross marks).
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4. Tape the sheets together from the back.

5. Repeat steps 1 to 4 to tape Sheet 3 and Sheet 4 together.

6. Cut off the margins of Sheet 1 and Sheet 2 along the horizontal blue line through the center of the left and right
side cross marks.
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7. Place the edge of Sheet 1 and Sheet 2 on top of Sheet 3 and Sheet 4 and align the cross marks, and then
temporarily tape them together from the back.
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8. Cut the taped sheets in two along the horizontal red line through the alignment markers (this time, the line
above the cross marks).

9. Tape the sheets together from the back.
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10. Cut off the remaining margins along the outer guide.

Printing with a Header and Footer
You can print information such as a user name and printing date in headers or footers.

Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Header/Footer. Click
Settings, and then select the items you want to print.
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Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56

Printing a Watermark
You can print a watermark such as "Confidential" or an anti-copy pattern on your printouts. If you print with an
anti-copy pattern, the hidden letters appear when photocopied in order to distinguish the original from the copies.

Anti-Copy Pattern is available under the following conditions:

❏ Paper: Plain paper, Copy paper, Letterhead, Recycled paper, Colored paper, Preprinted paper, or High quality
plain paper

❏ Quality: Standard

❏ Automatic 2-sided printing: Not selected

❏ Tone Correction: Automatic

Note:
You can also add your own watermark or anti-copy pattern.

Print Settings

On the printer driver's More Options tab, click Watermark Features, and then select Anti-Copy Pattern or
Watermark. Click Settings to change details such as the size, density, or position of the pattern or the mark.

Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56
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Printing Password-Protected Files
Yon can set a password for a print job so that it starts printing only after entering the password on the printer's
control panel.

Print Settings

On the printer driver's More Options tab, select Confidential Job, and then enter a password.

To print the job, select Confidential Job on the home screen of the printer's control panel. Select the job you want
to print, and then enter the password.

Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56

Printing Multiple Files Together
Job Arranger Lite allows you to combine several files created by different applications and print them as a single
print job. You can specify the print settings for combined files, such as multi-page layout, and 2-sided printing.

Print Settings

On the printer driver's Main tab, select Job Arranger Lite. When you start printing, the Job Arranger Lite window
is displayed. With the Job Arranger Lite window opened, open the file that you want to combine with the current
file, and then repeat the above steps.
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When you select a print job added to Print Project in the Job Arranger Lite window, you can edit the page layout.

Click Print from the File menu to start printing.

Note:
If you close the Job Arranger Lite window before adding all the print data to the Print Project, the print job you are currently
working on is canceled. Click Save from the File menu to save the current job. The extension of the saved files is "ecl".

To open a Print Project, click Job Arranger Lite on the printer driver's Maintenance tab to open the Job Arranger Lite
window. Next, select Open from the File menu to select the file.

Related Information

& “Printing Basics” on page 39
& “Main Tab” on page 56

Adjusting the Print Tone
You can adjust the tone used in the print job.

Note:
These adjustments are not applied to the original data.

Print Settings

On the printer driver's More Options tab, select Custom as the Tone Correction setting. Click Advanced to open
the Tone Correction window, and then select the method of tone correction.

Note:
❏ Automatic is selected as default on the More Options tab. This setting automatically adjusts the tone to match the paper

type and print quality settings.

Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56
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Printing to Emphasize Thin Lines
You can thicken thin lines that are too thin to print.

Print Settings

On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Emphasize
Thin Lines.

Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56

Printing to Enhance Light Text and Lines
You can enhance light letters and lines to make them more visible, or to sharpen images.

Print Settings

On the printer driver's More Options tab, click Image Options in the Tone Correction setting. Select Enhance
Light Text and Lines.

Related Information

& “Printing Basics” on page 39
& “More Options Tab” on page 56
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Printing Clear Bar Codes
You can print a bar code clearly and make it easy to scan. Only enable this feature if the bar code you printed
cannot be scanned.

You can use this feature under the following conditions.

❏ Paper: Plain paper, Copy paper, Letterhead, Recycled paper, Colored paper, Preprinted paper, High quality plain
paper, Thick paper, or Envelope

❏ Quality: Standard

Note:
Deblurring may not always be possible depending on the circumstances.

Print Settings

On the printer driver's Maintenance tab, click Extended Settings, and then select Barcode mode.

Related Information

& “Printing Basics” on page 39
& “Maintenance Tab” on page 57

Canceling Printing
You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.

Menu Options for the Printer Driver
Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.
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Main Tab

Printing Presets Add/Remove Presets You can add or remove your own presets for frequently used print
settings. Select the preset you want to use from the list.

Show Settings Displays a list of items currently set on the Main and More Options tabs.

Reset Defaults Return all settings to their factory default values. The settings on the More Options tab are also
reset to their defaults.

Ink Levels Displays the approximate ink levels.

Paper Source Select the paper source from which the paper is fed. Select Auto Select to automatically select the
paper source selected in Paper Setting on the printer.

Document Size Select the paper size on which you want to print. If you select User-Defined, enter the paper width
and height.

Orientation Select the orientation you want to use to print.

Paper Type Select the type of paper on which you print.

Quality Select the pint quality you want to use for printing. Available settings depend on the paper type
you select.

2-Sided Printing Allows you to perform 2-sided printing.

Settings You can specify the binding edge and the binding margins. When
printing multi-page documents, you can select to print starting from
either the front or the back side of the page.

Print Density Select the document type to adjust the print density. If the appropriate
print density is selected, you can prevent images from bleeding through
to the reverse side. Select User Defined to adjust the print density
manually.

Multi-Page Allows you to print several pages on one sheet or perform poster printing. Click Page Order to
specify the order in which pages are printed.

Copies Set the number of copies you want to print.

Collate Prints multi-page documents collated in order and sorted into sets.

Reverse Order Allows you to print from the last page so that the pages are stacked in the
correct order after printing.

Quiet Mode Reduces the noise the printer makes. However, enabling this may reduce print speed.

Print Preview Displays a preview of your document before printing.

Job Arranger Lite Select to print using the Job Arranger Lite feature.

More Options Tab

Printing Presets Add/Remove Presets You can add or remove your own presets for frequently used print
settings. Select the preset you want to use from the list.

Show Settings Displays a list of items currently set on the Main and More Options tabs.
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Reset Defaults Return all settings to their factory default values. The settings on the Main tab are also reset to their
defaults.

Document Size Select the size of your document.

Output Paper Select the paper size on which you want to print. If the Output Paper differs from Document Size,
Reduce/Enlarge Document is selected automatically. You do not have to select Output Paper
when printing documents without changing the size.

Reduce/Enlarge
Document

Allows you to reduce or enlarge the size of a document.

Fit to Page Automatically reduce or enlarge the document to fit to the paper size
selected in Output Paper.

Zoom to Prints with a specific percentage.

Center Prints images in the center of the paper.

Tone Correction Automatic Adjusts the tone of images automatically.

Custom Allows you to perform manual tone correction. Click Advanced for
further settings.

Image Options Enables print quality options such as Emphasize Text. You can also
thicken thin lines to make them visible on the printouts.

Watermark Features Allows you to make settings for anti-copy patterns or watermarks.

Confidential Job Password-protect confidential documents when printing. If you use this feature, the print data is
stored in the printer and can only be printed after the password has been entered using the
printer's control panel. Click Settings to change the settings.

Additional Settings Rotate 180° Rotates pages 180 degrees before printing. This feature is helpful when
printing on paper such as envelopes that are loaded in fixed direction in
the printer.

High Speed Prints when the print head moves in both directions. The print speed is
faster, but the quality may decline.

Mirror Image Inverts the image so that it prints as it would appear in a mirror.

Maintenance Tab

Nozzle Check Prints a nozzle check pattern to check if the print head nozzles are clogged.

Head Cleaning Cleans the clogged nozzles in the print head. Because this feature uses some ink, clean the print
head only if the nozzles are clogged.

Job Arranger Lite Opens the Job Arranger Lite window. You can save and edit data.

EPSON Status
Monitor 3

Opens the EPSON Status Monitor 3 window. Here you can confirm the status of the printer and the
consumables.

Monitoring
Preferences

Allows you to make settings for items on the EPSON Status Monitor 3 window.

Extended Settings Allows you to make a variety of settings. Right-click each item to view the Help for more details.

Print Queue Displays the jobs waiting to be printed. You can check, pause, or resume print jobs.
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Printer and Option
Information

You can register user accounts. If access control is set on the printer, you must register your
account.

Language Changes the language to be used on the printer driver window. To apply the settings, close the
printer driver, and then open it again.

Software Update Starts EPSON Software Updater to check for the latest version of applications on the Internet.

Technical Support Allows you to access the Epson technical support website.

Printing from the PostScript Printer Driver on
Windows
A PostScript Printer Driver is a driver that outputs printing commands to a printer using a PostScript Page
Description Language.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.

2. Select Print or Print Setup from the File menu

3. Select your printer.

4. Select Preferences or Properties to access the printer driver window.

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click OK to close the printer driver for details.
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7. Click Print.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “List of Paper Type” on page 28
& “Paper/Quality Tab” on page 59
& “Layout Tab” on page 59

Menu Options for the PostScript Printer Driver
Open the print window on an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Paper/Quality Tab

Tray Selection Paper Source Select the paper source from which the paper is fed.

Select Automatically Select to automatically select the paper
source selected in the Paper Setting on the printer.

Media Select the type of paper on which you print.

Layout Tab

Orientation Select the orientation you want to use to print.

Print on Both
Sides

Allows you to perform 2-sided printing.

Page Order Select to print from the top or the last page. If you select Back to Front, the pages are stacked in the
correct order based on page number after printing.

Page Format Pages per Sheet Allows you to print several pages on one sheet.

Pages per Sheet
Layout

Allows you to specify the page layout when printing several
pages on one sheet.

Booklet Select to create a booklet.

Booklet Binding Select the binding position for booklet.

Access Control Settings Tab

Printer usage may have been restricted by the administrator. Printing is available after registering your account to
the printer driver. Contact the administrator for details on your user account.
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Access Control Settings User Registration Allows you to enter a user name and password.

User Name Enter a user name.

Password Enter a password.

Advanced Options

Paper/Output Paper Size Select the paper size on which you want to print.

Copies Set the number of copies you want to print.

Graphic Print Quality Select the pint quality you want to use for printing.

Scaling Allows you to reduce or enlarge the document.

TrueType Font Sets the font substitute to TrueType Font.

Document Options Advanced Printing
Features

Allows you to make detailed settings for printing features.

PostScript Options Allows you to make optional settings.

Printer Features Ink Save Mode Conserves ink by reducing the print density.

Rotate by 180º Rotates the data 180 degrees before printing.

Canceling Printing
You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

On your computer, right-click on your printer in Devices and Printers, Printer, or in Printers and Faxes. Click
See what's printing, right-click on the job you want to cancel, and then select Cancel.

Printing from the Printer Driver on Mac OS

Printing Basics
Note:
Operations differ depending on the application. See the application's help for details.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.
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2. Select Print from the File menu or another command to access the print dialog.

If necessary, click Show Details ord to expand the print window.

3. Select your printer.

4. Select Print Settings from the pop-up menu.

Note:
On OS X Mountain Lion or later, if the Print Settings menu is not displayed, the Epson printer driver has not been
installed correctly.

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the
printer, and then add the printer again. See the following to add a printer.

http://epson.sn

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “List of Paper Type” on page 28
& “Menu Options for Print Settings” on page 66

User's Guide

Printing

61

http://epson.sn/?q=2


Printing on 2-Sides
You can print on both sides of the paper.

Note:
❏ If you do not use paper that is suitable for 2-sided printing, the print quality may decline and paper jams may occur.

❏ Depending on the paper and the data, ink may bleed through to the other side of the paper.

Related Information

& “Available Paper and Capacities” on page 20

Print Settings

Select Two-sided Printing Settings from the pop-up menu. Select the method of 2-sided printing, and then make
the Document Type settings.

Note:
❏ Printing speed may be reduced depending on the document type.

❏ When printing photos with dense data, select Text & Graphics or Text & Photos in the Document Type setting. If the
printouts are smeared or ink bleeds through to the other side of the paper, adjust the Print Density and Increased Ink
Drying Time in Adjustments.

Related Information

& “Printing Basics” on page 60
& “Menu Options for Two-sided Printing Settings” on page 66

User's Guide

Printing

62



Printing Several Pages on One Sheet
You can print two or four pages of data on a single sheet of paper.

Print Settings

Select Layout from the pop-up menu. Set the number of pages in Pages per Sheet, the Layout Direction (page
order), and Border.

Related Information

& “Printing Basics” on page 60
& “Menu Options for Layout” on page 65

Printing and Stacking in Page Order (Reverse Order Printing)
You can print from the last page so that the documents are stacked in page order.

Print Settings

Select Paper Handling from the pop-up menu. Select Reverse as the Page Order setting.

Related Information

& “Printing Basics” on page 60
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& “Menu Options for Paper Handling” on page 65

Printing a Reduced or Enlarged Document
You can reduce or enlarge the size of a document by a specific percentage or to fit the paper size you loaded in the
printer.

Print Settings

When printing to fit to the paper size, select Paper Handling from the pop-up menu, and then select Scale to fit
paper size. Select the paper size you loaded in the printer in Destination Paper Size. When reducing the size of
the document, select Scale down only.

When printing at a specific percentage, do one of the following.

❏ Select Print from the File menu of the application. Select Printer, enter a percentage in Scale, and then click
Print.

❏ Select Page Setup from the File menu of the application. Select your printer in Format For, enter a percentage
in Scale, and then click OK.

Note:
Select the paper size you set in the application as the Paper Size setting.

Related Information

& “Printing Basics” on page 60
& “Menu Options for Paper Handling” on page 65

Canceling Printing
You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.
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Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

❏ OS X Mountain Lion or later

Click  next to the progress meter.

❏ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Menu Options for the Printer Driver
Open the print window in an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet Select the number of pages to be printed on one sheet.

Layout Direction Specify the order in which the pages will be printed.

Border Prints a border around the pages.

Reverse page
orientation

Rotates pages 180 degrees before printing. Select this item when printing on paper such as
envelopes that are loaded in fixed direction in the printer.

Flip horizontally Inverts an image to print as it would appear in a mirror.

Menu Options for Color Matching

ColorSync Select the method for color adjustment. These options adjusts colors between the printer and the
computer display to minimize the difference in color.

EPSON Color Controls

Menu Options for Paper Handling

Collate pages Prints multi-page documents collated in order and sorted into sets.

Pages to Print Select to print only odd pages or even pages.

Page Order Select to print from the top or the last page.

Scale to fit paper size Prints to fit to the paper size you loaded.

Destination Paper
Size

Select the paper size to print on.

Scale down only Select when reducing the size of the document.
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Menu Options for Cover Page

Print Cover Page Select whether or not to print a cover page. When you want to add a back cover, select After
document.

Cover Page Type Select the contents of the cover page.

Menu Options for Print Settings

Paper Source Select the paper source from which the paper is fed. If the printer has only one paper source, this
item is not displayed. Selecting Auto Select selects the paper source that matches the Paper
Setting on the printer automatically.

Media Type Select the type of paper on which you print.

Print Quality Select the pint quality you want to use for printing. The options vary depending on the paper type.

Advanced Settings Adjusts the brightness and the contrast of images.

Menu Options for Two-sided Printing Settings

Two-sided Printing Prints on both sides of the paper.

Making Operation Settings for the Mac OS Printer Driver

Accessing the Operation Settings Window of the Mac OS Printer Driver

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver).

Operation Settings of the Mac OS Printer Driver

❏ Thick paper and envelopes: Prevents the ink from smearing when printing on thick paper. However, this may
reduce print speed.

❏ Skip Blank Page: Avoids printing blank pages.

❏ Quiet Mode: Reduces the noise the printer makes, however, may reduce print speed.

❏ High Speed Printing: Prints when the print head moves in both directions. The print speed is faster, but the
quality may decline.

❏ Output documents for filing: Feed the paper so that it is easy to file when printing landscape data or 2-sided
printing. Envelope printing is not supported.

❏ Warning Notifications: Allows the printer driver to display warning notifications.

❏ Establish bidirectional communication: Usually, this should be set to On. Select Off when acquiring the printer
information is impossible because the printer is shared with Windows computers on a network or for any other
reason.
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Printing from the PostScript Printer Driver on Mac OS
A PostScript Printer Driver is a driver that outputs printing commands to a printer using a PostScript Page
Description Language.

1. Open the file you want to print.

Load paper in the printer if it has not already been loaded.

2. Select Print or Print Setup from the File menu.

If necessary, click Show Details or d to expand the print window.

3. Select your printer.

4. Select Print Features from the pop-up menu.

5. Change the settings as necessary.

See the menu options for the printer driver for details.

6. Click Print.

Related Information

& “Available Paper and Capacities” on page 20
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “List of Paper Type” on page 28
& “Menu Options for Printer Features” on page 69
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Menu Options for the PostScript Printer Driver
Open the print window on an application, select the printer, and then access the printer driver window.

Note:
Menus vary depending on the option you selected.

Menu Options for Layout

Pages per Sheet Select the number of pages to be printed on one sheet.

Layout Direction Specify the order in which the pages will be printed.

Border Prints a border around the pages.

Two-Sided Allows you to perform 2-sided printing.

Reverse page
orientation

Rotates pages 180 degrees before printing.

Flip horizontally Inverts the image so that it prints as it would appear in a mirror.

Menu Options for Color Matching

ColorSync Select the method for color adjustment. These options adjusts color between the printer and the
computer display to minimize the difference in color.

In Printer

Menu Options for Paper Handling

Collate pages Prints multi-page documents collated in order and sorted into sets.

Pages to Print Select to print only odd pages or even pages.

Page Order Select to print from the top or the last page.

Scale to fit paper size Prints to fit to the paper size you loaded.

Destination Paper
Size

Select the paper size to print on.

Scale down only Select when reducing the size of the document.

Menu Options for Paper Feed

All Pages From Select the paper source from which the paper is fed.

Selecting Auto Select selects the paper source that matches the Paper Setting on the printer
automatically.

You can also select the paper source for page.

First Page From/
Remaining From
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Menu Options for Cover Page

Print Cover Page Select whether or not to print a cover page. When you want to add a back cover, select After
document.

Cover Page Type Select the contents of the cover page.

Menu Options for Printer Features

Feature Sets Quality MediaType Select the type of paper on which you print.

Print Quality Select the pint quality you want to use for printing.

Others Ink Save Mode Conserves ink by reducing the print density.

Canceling Printing
You can cancel a print job from the computer. However, you cannot cancel a print job from the computer once it
has been completely sent to the printer. In this case, cancel the print job by using the printer's control panel.

Canceling

Click the printer icon in the Dock. Select the job you want to cancel, and then do one of the following.

❏ OS X Mountain Lion or later

Click  next to the progress meter.

❏ Mac OS X v10.6.8 to v10.7.x
Click Delete.

Printing from Smart Devices

Using Epson iPrint
Epson iPrint is an application that allows you to print photos, documents, and web pages from a smart device such
as a smartphone or tablet. You can use local print, printing from a smart device that is connected to the same
wireless network as your printer, or remote print, printing from a remote location over the Internet. To use remote
print, register your printer in the Epson Connect service.
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Related Information

& “Printing Using a Network Service” on page 90

Connecting from Smart Device by Wi-Fi Direct

You need to connect the smart device to the printer to print from the smart device.

Wi-Fi Direct allows you to connect the printer directly to devices without an access point. The printer acts as an
access point.

c
Important:

When you connect from a smart device to the printer using the Wi-Fi Direct (Simple AP) connection, the printer is
connected to the same Wi-Fi network (SSID) as the smart device and the communication is established between
them. Since the smart device is automatically connected to the other connectable Wi-Fi network if the printer is
turned off, it is not connected to the previous Wi-Fi network again if the printer is turned on. Connect to the
printer's SSID for Wi-Fi Direct (Simple AP) connection from the smart device again.

1. Select  on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

2. Select Wi-Fi Direct.

3. Press the OK button.

If you have made Wi-Fi Direct (Simple AP) settings, the detailed connection information is displayed. Go to
step 5.

4. Press the OK button.

5. Check the SSID and password displayed on the printer's control panel. On the smart device's Wi-Fi screen,
select the SSID shown on the printer's control panel to connect.

Note:
You can check the connection method on the Web site. To access the Web site, scan the QR code displayed on the
printer's control panel using the smart device , and then go to Setup.

6. Enter the password displayed on the printer's control panel on the smart device.
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7. After the connection is established, select Dismiss or Close on the printer's control panel.

8. Close the screen.

Installing Epson iPrint

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/c

Printing Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice. The contents may vary depending on the product.

A Home screen displayed when the application is started.

B Displays information on how to setup the printer and a FAQ.

C Displays the screen where you can select the printer and make printer settings. Once you have selected the
printer, you do not need to select it again from the next time.

D Select what you want to print such as photos and documents.

E Displays the screen to make print settings such as paper size and paper type.
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F Displays the paper size. When this is displayed as a button, tap it to display the paper settings currently set
on the printer.

G Displays photos and documents you selected.

H Starts printing.

Note:
To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.

Printing by Touching Smart Devices to the N-Mark

You can simply connect and print by touching your smart device to the printer's N-Mark.

Make sure that you prepare the following before using this feature.

❏ Enable the NFC function on your smart device.
Only Android 4.0 or later supports NFC (Near Field Communication).
The location and NFC functions vary depending on the smart device. See the documentation provided with
your smart device for details.

❏ Install Epson iPrint on your smart device.
Touch your smart device to the printer's N-Mark to install it.

❏ Enable Wi-Fi Direct on your printer.
See the Administrator's Guide for details.

1. Load paper in the printer.

2. Touch your smart device to the printer's N-Mark.

Epson iPrint starts.

Note:
❏ The printer may not be able to communicate with the smart device when there are obstacles such as metal between

the printer's N-Mark and the smart device.

❏ Administrators may block this feature. In this case, smart devices only make a sound and do not start any
applications even if you touch them to the printer's N-Mark.

3. Select the file you want to print in Epson iPrint.
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4. On the preview screen with the Print icon, touch the smart device to the printer's N-Mark.

Printing starts.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25

Using Epson Print Enabler
You can wirelessly print your documents, emails, photos, and web pages right from your Android phone or tablet
(Android v4.4 or later). With a few taps, your Android device will discover an Epson printer that is connected to
the same wireless network.

1. Load paper in the printer.

2. Set up your printer for wireless printing.

3. On your Android device, install the Epson Print Enabler plug-in from Google Play.

4. Connect your Android device to the same wireless network as your printer.

5. Go to Settings on your Android device, select Printing, and then enable Epson Print Enabler.

6. From an Android application such as Chrome, tap the menu icon and print whatever is on the screen.

Note:
If you do not see your printer, tap All Printers and select your printer.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25

Using AirPrint
AirPrint enables instant wireless printing from iPhone, iPad, and iPod touch with the latest version of iOS, and
Mac with the latest version of OS X or macOS.
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Note:
If you disabled paper configuration messages on your product control panel, you cannot use AirPrint. See the link below to
enable the messages, if necessary.

1. Load paper in your product.

2. Set up your product for wireless printing. See the link below.

http://epson.sn

3. Connect your Apple device to the same wireless network that your product is using.

4. Print from your device to your product.

Note:
For details, see the AirPrint page on the Apple website.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25

Canceling Ongoing Jobs

Press the y button to cancel the ongoing job.
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Replacing an Ink Supply Unit and Other
Consumables

Checking the Status of the Remaining Ink and the
Maintenance Box
You can check the approximate ink levels and the approximate service life of the maintenance box from the control
panel or the computer.

Note:
You can continue printing while the ink low message is displayed. Replace the ink supply unit when required.

Checking the Status of the Remaining Ink and the Maintenance Box
- Control Panel

1. Select Settings on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

2. Select Supply Status.

Checking the Status of the Remaining Ink and the Maintenance Box
- Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab, and then click Details.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Checking the Status of the Remaining Ink and the Maintenance Box
- Mac OS

1. Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.
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Ink Supply Unit Codes
Epson recommends the use of genuine Epson ink supply units. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic printer behavior. Information about non-genuine ink levels may
not be displayed.

The following are the codes for genuine Epson ink supply units.

Note:
❏ Ink supply unit codes may vary by location. For the correct codes in your area, contact Epson support.

❏ Not all ink supply units are available in all regions.

For Europe

Size Black

XXL T9661

XL T9651

L T9641

Visit the following website for information on Epson's ink supply unit yields.

http://www.epson.eu/pageyield

Ink Supply Unit Handling Precautions
Read the following instructions and Important Safety Instructions (paper manual) before replacing Ink Supply Unit.

Handling precautions

❏ Store ink supply unit at normal room temperature and keep them away from direct sunlight.

❏ Epson recommends using the ink supply unit before the date printed on the package.

❏ For best results, store ink supply unit packages with their bottom down.

❏ After bringing an ink supply unit inside from a cold storage site, allow it to warm up at room temperature for at
least 12 hours before using it.

❏ Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

User's Guide

Replacing an Ink Supply Unit and Other Consumables

76

http://www.epson.eu/pageyield


❏ Do not turn off the printer during ink charging. If the ink charging is incomplete, you may not be able to print.

❏ Do not leave the printer with the ink supply unit removed; otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

❏ If you need to remove an ink supply unit temporarily, make sure you protect the ink supply area from dirt and
dust. Store the ink supply unit in the same environment as the printer. Because the ink supply port is equipped
with a valve designed to contain the release of excess ink, there is no need to supply your own covers or plugs.

❏ Removed ink supply unit may have ink around the ink supply port, so be careful not to get any ink on the
surrounding area when removing the ink supply unit.

❏ This printer uses an ink supply unit equipped with a green chip that monitors information such as the amount
of remaining ink. This means that even if the ink supply unit is removed from the printer before it is expended,
you can still use the ink supply unit after reinserting it back into the printer.

❏ To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the ink supply unit when your printer indicates to replace the ink supply unit. The yields quoted for
you do not include this reserve.

❏ Although the ink supply units may contain recycled materials, this does not affect printer function or
performance.

❏ Specifications and appearance of the ink supply unit are subject to change without prior notice for
improvement.

❏ Do not disassemble or remodel the ink supply unit, otherwise you may not be able to print normally.

❏ Do not drop or knock the ink supply unit against hard objects; otherwise, the ink may leak.

❏ You cannot use the ink supply unit that came with the printer for the replacement.

❏ Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Consumption of Ink

❏ To maintain optimum print head performance, some ink is consumed from the ink supply unit during
maintenance operations such as print head cleaning. Ink may also be consumed when you turn on the printer.

❏ The ink in the ink supply unit supplied with your printer is partly used during initial setup. In order to produce
high quality printouts, the print head in your printer will be fully charged with ink. This one-off process
consumes a quantity of ink and therefore the ink supply unit may print fewer pages compared to subsequent ink
supply unit.

❏ For best results, use up ink supply unit within two years of installation.

Replacing an Ink Supply Unit
When a message is displayed prompting you to replace the ink supply unit, select How To and then view the
animations displayed on the control panel to learn how to replace the ink supply unit.

Related Information

& “Ink Supply Unit Codes” on page 76
& “Ink Supply Unit Handling Precautions” on page 76
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Maintenance Box Code
Epson recommends the use of a genuine Epson maintenance box.

Maintenance box code: T6716

c
Important:

Once a maintenance box has been installed in a printer it cannot be used with other printers.

Maintenance Box Handling Precautions
Read the following instructions and Important Safety Instructions (paper manual) before replacing the
maintenance box.

❏ Do not touch the green chip on the side of the maintenance box. Doing so may prevent normal operation and
printing.

❏ Do not tilt the used maintenance box until after it is sealed in the plastic bag; otherwise ink may leak.

❏ Keep the maintenance box out of direct sunlight.

❏ Do not replace the maintenance box during printing; otherwise, ink may leak.

❏ Do not reuse a maintenance box which has been removed and left detached for a long period. Ink inside the box
will have solidified and no more ink can be absorbed.

Replacing a Maintenance Box
In some print cycles a very small amount of surplus ink may be collected in the maintenance box. To prevent ink
leakage from the maintenance box, the printer is designed to stop printing when the absorbing capacity of the
maintenance box has reached its limit. Whether and how often this is required will vary according to the number
of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs.

When a message is displayed prompting you to replace the maintenance box, refer to the animations displayed on
the control panel. The need for replacement of the box does not mean that your printer has ceased to operate in
accordance with its specifications. The Epson warranty does not cover the cost of this replacement. It is a user-
serviceable part.

Note:
When it is full, you cannot print until the maintenance box is replaced to avoid ink leakage.

Related Information

& “Maintenance Box Handling Precautions” on page 78
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Maintaining the Printer

Checking and Cleaning the Print Head
If the nozzles are clogged, the printouts become faint or banding may appear. When print quality has declined, use
the nozzle check feature and check if the nozzles are clogged. If the nozzles are clogged, clean the print head. You
can perform a nozzle check and head cleaning from the control panel or the computer.

c
Important:

❏ Do not open the front cover or turn off the printer during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

❏ Because print head cleaning uses some ink, clean the print head only if quality declines.

❏ When ink is low, you may not be able to clean the print head.

❏ If print quality has not improved after repeating nozzle check and head cleaning about four times, wait for at
least six hours without printing, and then run the nozzle check again and repeat the head cleaning if necessary.
We recommend to turn off the printer. If print quality has still not improved, contact Epson support.

❏ To prevent the print head from drying out, do not unplug the printer while the power is on.

Checking and Cleaning the Print Head - Control Panel

1. Load A4-size plain paper in the paper cassette.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

3. Select Print Head Nozzle Check.

4. Follow the on-screen instructions to print the nozzle check pattern.

5. Examine the printed pattern. If there are broken lines or missing segments as shown in the "NG" pattern, the
print head nozzles may be clogged. Go to the next step. If you cannot see any broken lines or missing segments

as in the following "OK" pattern, the nozzles are not clogged. Select  to close the nozzle check feature.

6. Select , and then follow the on-screen instructions to clean the print head.
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7. When cleaning is finished, print the nozzle check pattern again. Repeat cleaning and printing the pattern until
all lines are printed completely.

Related Information

& “Loading Paper in the Paper Cassette” on page 23

Checking and Cleaning the Print Head - Windows

1. Load A4-size plain paper in the paper cassette.

2. Access the printer driver window.

3. Click Nozzle Check on the Maintenance tab.

4. Follow the on-screen instructions.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Accessing the Printer Driver” on page 39

Checking and Cleaning the Print Head - Mac OS

1. Load A4-size plain paper in the paper cassette.

2. Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

3. Click Options & Supplies > Utility > Open Printer Utility.

4. Click Nozzle Check.

5. Follow the on-screen instructions.

Related Information

& “Loading Paper in the Paper Cassette” on page 23

Aligning the Print Head
If you notice a misalignment of vertical lines or blurred images, align the print head.

Aligning the Print Head - Control Panel
Note:
You may need to align the print head if your environment or paper type changes after aligning it.
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1. Load A4-size plain paper in the paper cassette.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

3. Select Print Head Alignment.

4. Select one of the alignment menus.

❏ Ruled Line Alignment: Select this if vertical ruled lines appear misaligned.

❏ Horizontal Alignment: Select this if you see horizontal banding at regular intervals.

5. Follow the on-screen instructions to print an alignment pattern.

6. Follow the on-screen instructions to align the print head.

❏ Ruled Line Alignment: Find and select the number for the most solid pattern.

Find and select the number for the pattern that has the least misaligned vertical line.

❏ Horizontal Alignment: Find and select the number for the least separated and overlapping pattern.
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Related Information

& “Loading Paper in the Paper Cassette” on page 23

Cleaning the Paper Path for Ink Smears
When the printouts are smeared or scuffed, clean the roller inside.

c
Important:

Do not use tissue paper to clean the inside of the printer. The print head nozzles may be clogged with lint.

1. Load A4-size plain paper in the paper cassette.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

3. Select Paper Guide Cleaning.

4. Follow the on-screen instructions to clean the paper path.

Note:
Repeat this procedure until the paper is not smeared with ink.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
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Network Service and Software
Information
This section introduces the network services and software products available for your printer from the Epson
website or the supplied software disc.

Application for Configuring Printer Operations (Web
Config)
Web Config is an application that runs in a web browser, such as Internet Explorer and Safari, on a computer or
smart device. You can confirm the printer status or change the network service and printer settings. To use the
Web Config, connect the printer and the computer or device to the same network.

The following browsers are supported.

OS Browser

Windows XP SP3 or later Microsoft Edge, Internet Explorer 8 or later, Firefox*, Chrome*

Mac OS X v10.6.8 or later Safari*, Firefox*, Chrome*

iOS* Safari*

Android 2.3 or later Default browser

Chrome OS* Default browser

* Use the latest version.

Running Web Config on a Web Browser

1. Check the printer's IP address.

Select the network icon on the printer's home screen, and then select the active connection method to confirm
the printer's IP address.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

Note:
You can also check the IP address by printing the network connection report.

2. Launch a Web browser from a computer or smart device, and then enter the printer's IP address.

Format:

IPv4: http://the printer's IP address/

IPv6: http://[the printer's IP address]/

Examples:

IPv4: http://192.168.100.201/
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IPv6: http://[2001:db8::1000:1]/

Note:
Using the smart device, you can also run Web Config from the maintenance screen of Epson iPrint.

Related Information

& “Using Epson iPrint” on page 69

Running Web Config on Windows
When connecting a computer to the printer using WSD, follow the steps below to run Web Config.

1. Access the devices and printers screen in Windows.

❏ Windows 10/Windows Server 2016
Right-click the start button or press and hold it, and then select Control Panel > View devices and printers
in Hardware and Sound.

❏ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).

❏ Windows 7/Windows Server 2008 R2
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.

❏ Windows Vista/Windows Server 2008
Click the start button, and select Control Panel > Printers in Hardware and Sound.

2. Right-click on your printer and select Properties.

3. Select the Web Service tab and click the URL.

Running Web Config on Mac OS

1. Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies> Show Printer Webpage.

Application for Printing Web Pages (E-Web Print)(for
Windows Only)
E-Web Print is an application that allows you to easily print web pages with various layouts. See the application's
help for details. You can access the help from the E-Web Print menu on the E-Web Print tool bar.

Note:
❏ Windows Server operating systems are not supported.

❏ Check for supported browsers and the latest version from the download site.
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Starting

When you install E-Web Print, it is displayed in your browser. Click Print or Clip.

Software Update Tools (EPSON Software Updater)
EPSON Software Updater is an application that checks for new or updated software on the internet and installs it.
You can also update the printer's firmware and manual.

Note:
Windows Server operating systems are not supported.

Installing Method

Download EPSON Software Updater from the Epson website.

If you are using a Windows computer and cannot to download it from the website, you can install it from the
supplied software disc.

http://www.epson.com

Starting on Windows

❏ Windows 10
Click the start button, and then select Epson Software > EPSON Software Updater.

❏ Windows 8.1/Windows 8
Enter the application name in the search charm, and then select the displayed icon.

❏ Windows 7/Windows Vista/Windows XP
Click the start button, and then select All Programs or Programs > Epson Software > EPSON Software
Updater.

Note:
You can also start EPSON Software Updater by clicking the printer icon on the task bar on the desktop, and then selecting
Software Update.

Starting on Mac OS

Select Go > Applications > Epson Software > EPSON Software Updater.

Installing the Latest Applications
Note:
When reinstalling an application, you need to uninstall it first.

1. Make sure the printer and the computer are available for communication, and the printer is connected to the
Internet.

User's Guide

Network Service and Software Information

85

http://www.epson.com/


2. Start EPSON Software Updater.

The screenshot is an example on Windows.

3. For Windows, select your printer, and then click  to check for the latest available applications.

4. Select the items you want to install or update, and then click the install button.

c
Important:

Do not turn off or unplug the printer until the update is complete; otherwise, the printer may malfunction.

Note:
❏ You can download the latest applications from the Epson website.

http://www.epson.com

❏ If you use Windows Server operating systems, you cannot use EPSON Software Updater. Download the latest
applications from the Epson website.

Related Information

& “Software Update Tools (EPSON Software Updater)” on page 85
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Installing a PostScript Printer Driver

Installing a PostScript Printer Driver - Windows

1. Start the installation process from one of the following options.

❏ Use the software disc supplied with the printer.
Insert the software disc into the computer, access the following folder path, and then run SETUP64.EXE (or
SETUP.EXE).
Driver\PostScript\WINX64 (or WINX86)\SETUP\SETUP64.EXE ( or SETUP.EXE)

❏ Use the website.
Access your printer page from the following website, download the PostScript3 printer driver, and then run
the execution file.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (outside Europe)

2. Select your printer.

3. Follow the on-screen instructions.

4. Select the connection method from the network connection or USB connection.

❏ For network connection.
A list of available printers in the same network is displayed.
Select the printer you want to use.

❏ For USB connection.
Follow the on-screen instructions to connect the printer to the computer.

5. Follow the on-screen instructions to install the PostScript printer driver.

Installing a PostScript Printer Driver - Mac OS
Download the printer driver from the Epson Support website, and then install it.

http://www.epson.eu/Support (Europe)

http://support.epson.net/ (outside Europe)

You need the IP address of the printer while installing the printer driver.

Select the network icon on the printer's home screen, and then select the active connection method to confirm the
printer's IP address.

Adding the Printer Driver (for Mac OS Only)

1. Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax).

2. Click +, and then select Add Other Printer or Scanner.
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3. Select your printer, and then click Add.

Note:
If your printer is not listed, check that it is correctly connected to the computer and that the printer is on.

Installing the Epson Universal Printer Driver (for
Windows Only)
The Epson universal printer driver is the universal PCL6 compatible print driver. Once you install this printer
driver*, you can print from every Epson printer that supports this printer driver.
* Since this is a generic printer driver, printing features are limited compared to the printer driver specifically designed for this

printer.

Connect the printer to the same network as the computer, and then follow the procedure below to install the
printer driver.

1. Download the executable file of the driver from the Epson support website.

http://www.epson.eu/Support (Europe only)

http://support.epson.net/

2. Double-click the executable file.

3. Follow the on-screen instructions for the rest of the installation.

Note:
If you are using a Windows computer and you cannot download the driver from the website, install it from the software
disc that came with the printer. Access "Driver\Universal".

Uninstalling Applications
Log in to your computer as an administrator. Enter the administrator password if the computer prompts you.

Uninstalling Applications - Windows

1. Press the P button to turn off the printer.

2. Quit all running applications.

3. Open Control Panel:

❏ Windows 10/Windows Server 2016
Click on the start button, and then select Windows System > Control Panel.

❏ Windows 8.1/Windows 8/Windows Server 2012 R2/Windows Server 2012
Select Desktop > Settings > Control Panel.

❏ Windows 7/Windows Vista/Windows XP/Windows Server 2008 R2/Windows Server 2008/Windows Server
2003 R2/Windows Server 2003
Click the start button and select Control Panel.
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4. Open Uninstall a program (or Add or Remove Programs):

❏ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008
Select Uninstall a program in Programs.

❏ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click Add or Remove Programs.

5. Select the application you want to uninstall.

You cannot uninstall the printer driver if there is any print jobs. Delete or wait to be printed the jobs before
uninstalling.

6. Uninstall the applications:

❏ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Vista/Windows Server 2016/Windows Server
2012 R2/Windows Server 2012/Windows Server 2008 R2/Windows Server 2008
Click Uninstall/Change or Uninstall.

❏ Windows XP/Windows Server 2003 R2/Windows Server 2003
Click Change/Remove or Remove.

Note:
If the User Account Control window is displayed, click Continue.

7. Follow the on-screen instructions.

Uninstalling Applications - Mac OS

1. Download the Uninstaller using EPSON Software Updater.

Once you have downloaded the Uninstaller, you do not need to download it again each time you uninstall the
application.

2. Press the P button to turn off the printer.

3. To uninstall the printer driver, select System Preferences from the  menu > Printers & Scanners (or Print
& Scan, Print & Fax), and then remove the printer from the enabled printers list.

4. Quit all running applications.

5. Select Go > Applications > Epson Software > Uninstaller.

6. Select the application you want to uninstall, and then click Uninstall.

c
Important:

The Uninstaller removes all drivers for Epson inkjet printers on the computer. If you use multiple Epson inkjet
printers and you only want to delete some drivers, delete all of them first, and then install the necessary printer
driver again.
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Note:
If you cannot find the application you want to uninstall in the application list, you cannot uninstall using the
Uninstaller. In this situation, select Go > Applications > Epson Software, select the application you want to uninstall,
and then drag it to the trash icon.

Printing Using a Network Service
By using Epson Connect service available on the Internet, you can print from your smartphone, tablet PC, or
laptop, anytime and practically anywhere. To use this service, you need to register the user and the printer in
Epson Connect.

The features available on the Internet are as follows.

❏ Email Print
When you send an email with attachments such as documents or images to an email address assigned to the
printer, you can print that email and the attachments from remote locations such as your home or office printer.

❏ Epson iPrint
This Application is for iOS and Android, and allows you to print from a smart phone or tablet. You can print
documents, images, and websites by sending them directly to a printer on the same wireless LAN.

❏ Remote Print Driver
This is a shared driver supported by Remote Print Driver. When printing using a printer in a remote location,
you can print by changing the printer on the usual applications window.

See the Epson Connect portal website for details.

https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Related Information

& “Using Epson iPrint” on page 69

User's Guide

Network Service and Software Information

90

https://www.epsonconnect.com/
http://www.epsonconnect.eu/


Solving Problems

Checking the Printer Status

Checking Messages on the LCD Screen
If an error message is displayed on the LCD screen, follow the on-screen instructions or the solutions below to
solve the problem.

Error Messages Solutions

Printer Error

Turn on the printer again. See your
documentation for more details.

❏ Remove any paper or protective material in the printer and the paper
cassette. If the error message is still displayed after turning the power
off and on again, contact Epson support.

❏ When the following error codes are displayed, check the paper for
the maximum number of sheets that can be loaded in each paper
source.

000181, 000184

Paper out in XX. Load paper, and then insert the paper cassette all the way.

You need to replace Ink Supply Unit. To ensure you receive premium print quality and to help protect your
print head, a variable ink safety reserve remains in the ink supply unit
when your printer indicates it is time to replace the ink supply unit.
Replace with a new ink supply unit.

Paper Setup Auto Display is set to Off. Some
features may not be available. For details, see
your documentation.

If Paper Setup Auto Display is disabled, you cannot use AirPrint.

The combination of the IP address and the
subnet mask is invalid. See your documentation
for more details.

Contact your printer administrator.

To use cloud services, update the root certificate
from the Epson Web Config utility.

Contact your printer administrator.

Check that the printer driver is installed on the
computer and that the port settings for the
printer are correct.

Make sure the printer port is selected correctly in Property > Port from
the Printer menu as follows.

Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a
network connection.Check that the printer driver is installed on the

computer and that the USB port settings for the
printer are correct.

Recovery Mode Contact your printer administrator.

Related Information

& “Contacting Epson Support” on page 125
& “Software Update Tools (EPSON Software Updater)” on page 85
& “Installing the Latest Applications” on page 85
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Checking the Printer Status - Windows

1. Access the printer driver window.

2. Click EPSON Status Monitor 3 on the Maintenance tab, and then click Details.

You can check the printer status, ink levels, and error status.

Note:
If EPSON Status Monitor 3 is disabled, click Extended Settings on the Maintenance tab, and then select Enable
EPSON Status Monitor 3.

Related Information

& “Accessing the Printer Driver” on page 39

Checking the Printer Status - Mac OS

1. Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer.

2. Click Options & Supplies > Utility > Open Printer Utility.

3. Click EPSON Status Monitor.

You can check the printer status, ink levels, and error status.

Checking the Software Status
You may be able to clear the problem by updating the software to the latest version. To check the software status,
use the software update tool.

Related Information

& “Software Update Tools (EPSON Software Updater)” on page 85
& “Installing the Latest Applications” on page 85

Removing Jammed Paper
Follow the on-screen instructions on the printer's control panel to locate and remove the jammed paper including
any torn pieces. The LCD screen displays an animation that shows you how to remove jammed paper.

!Caution:

Never touch the buttons on the control panel while your hand is inside the printer. If the printer starts operating, it
could cause an injury. Be careful not to touch the protruding parts to avoid injury.
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c
Important:

Remove the jammed paper carefully. Removing the paper vigorously may cause damage to the printer.

Paper Does Not Feed Correctly
Check the following points, and then take the appropriate actions to solve the problem.

❏ Place the printer on a flat surface and operate in the recommended environmental conditions.

❏ Use paper supported by this printer.

❏ Follow the paper handling precautions.

❏ Do not load more than the maximum number of sheets specified for the paper. For plain paper, do not load
above the line indicated by the  symbol on the edge guide. For thick paper such as photo paper, do not

load above the line indicated by the  symbol on the edge guide.

❏ Make sure the paper size and paper type settings match the actual paper size and paper type loaded in the
printer.

❏ If a paper feed problem frequently occurs, feed paper from another paper source.

Related Information

& “Environmental Specifications” on page 113
& “Paper Handling Precautions” on page 22
& “Available Paper and Capacities” on page 20
& “List of Paper Type” on page 28

Paper Jams
Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

& “Removing Jammed Paper” on page 92
& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25

Paper Feeds at a Slant
Load paper in the correct direction, and slide the edge guides against the edges of the paper.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
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Several Sheets of Paper are Fed at a Time
When several sheets of paper are fed at a time during manual 2-sided printing, remove any paper which is loaded
in the printer before you reload the paper.

Power and Control Panel Problems

Power Does Not Turn On
❏ Make sure the power cord is securely plugged in.

❏ Hold down the P button for a little longer.

Power Does Not Turn Off

Hold down the P button for a little longer. If you still cannot turn off the printer, unplug the power cord. To
prevent the print head from drying out, turn the printer back on and turn it off by pressing the P button.

Power Turns Off Automatically
❏ Select Settings > General Settings > Basic Settings > Power Off Settings, and then disable the Power Off If

Inactive and Power Off If Disconnected settings.

❏ Select Settings > General Settings > Basic Settings, and then disable the Power Off Timer setting.

Note:
Your product may have the Power Off Settings or Power Off Timer feature depending on the location of purchase.

LCD Screen Gets Dark
The printer is in sleep mode. Press any button on the control panel to return the LCD screen to its former state.

Cannot Operate from the Control Panel
When the user feature restriction is enabled, a user ID and password are required to print. If you do not know the
password, contact your printer administrator.

Cannot Print from a Computer

Checking the Connection (USB)
❏ Connect the USB cable securely to the printer and the computer.
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❏ If you are using a USB hub, try to connect the printer directly to the computer.

❏ If the USB cable cannot be recognized, change the port, or change the USB cable.

❏ If the printer cannot print using a USB connection, try the following.
Disconnect the USB cable from the computer. Right-click on the printer icon displayed on the computer, and
then select Remove Device. Next, connect the USB cable to the computer and try a test print.
Re-set the USB connection by following the steps in this manual for changing the connection method to a
computer. See the related information link below for details.

Checking the Connection (Network)
❏ Select Settings > General Settings > Network Settings > Connection Check, and then print the network

connection report. If the report shows that network connection has failed, check the network connection report
and then contact your printer administrator.

❏ If the problem cannot be cleared, contact your printer administrator.

Checking the Software and Data
❏ Make sure that a genuine Epson printer driver is installed. If a genuine Epson printer driver is not installed, the

available functions are limited. We recommend using a genuine Epson printer driver. See the related
information link below for details.

❏ If you are printing a large data size image, the computer may run out of memory. Print the image at a lower
resolution or a smaller size.

Related Information

& “Checking for Genuine Epson Printer Drivers” on page 95

Checking for Genuine Epson Printer Drivers

You can check if a genuine Epson printer driver is installed on your computer by using one of the following
methods.

User's Guide

Solving Problems

95



Windows

Select Control Panel > View devices and printers (Printers, Printers and Faxes), and then do the following to
open the print server properties window.

❏ Windows 10/Windows 8.1/Windows 8/Windows 7/Windows Server 2016/Windows Server 2012 R2/Windows
Server 2012/Windows Server 2008 R2
Click the printer icon, and then click Print server properties at the top of the window.

❏ Windows Vista/Windows Server 2008
Right-click on the Printers folder, and then click Run as administrator > Server Properties.

❏ Windows XP/Windows Server 2003 R2/Windows Server 2003
From the File menu, select Server Properties.

Click the Driver tab. If your printer name is displayed in the list, a genuine Epson printer driver is installed on
your computer.
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Mac OS

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies, and if the Options tab and Utility tab are displayed on the window, a
genuine Epson printer driver is installed on your computer.

Related Information

& “Installing the Latest Applications” on page 85

Checking the Printer Status from the Computer (Windows)
Click Print Queue on the printer driver's Maintenance tab, and then check the following.

❏ Check if there are any paused print jobs.
If unnecessary data remains, select Cancel all documents from the Printer menu.
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❏ Make sure the printer is not offline or pending.
If the printer is offline or pending, clear the offline or pending setting from the Printer menu.

❏ Make sure the printer is selected as the default printer from the Printer menu (there should be a check mark on
the menu item).
If the printer is not selected as the default printer, set it as the default printer. If there are multiple icons in
Control Panel > View devices and printers (Printers, Printers and Faxes), see the following to select the icon.
Example)
USB connection: EPSON XXXX Series
Network connection: EPSON XXXX Series (network)
If you install the printer driver multiple times, copies of printer driver may be created. If copies such as "EPSON
XXXX Series (copy 1)" are created, right-click the copied driver icon, and then click Remove Device.

❏ Make sure the printer port is selected correctly in Property > Port from the Printer menu as follows.
Select "USBXXX" for a USB connection, or "EpsonNet Print Port" for a network connection.

Checking the Printer Status from the Computer (Mac OS)
❏ The printer may not print when the user feature restriction is enabled. Contact your printer administrator.

❏ Make sure the printer status is not Pause.

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
double-click the printer. If the printer is paused, click Resume (or Resume Printer).

Cannot Print from an iPhone or iPad
❏ Connect the iPhone or iPad to the same network (SSID) as the printer.

❏ Enable Paper Setup Auto Display in the following menus.
Settings > General Settings > Printer Settings > Paper Source Settings > Paper Setup Auto Display

❏ Enable the AirPrint setting on Web Config.

Related Information

& “Application for Configuring Printer Operations (Web Config)” on page 83
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Printout Problems

Adjusting the Print Quality
If you notice a misaligned vertical lines, blurred images, or horizontal banding, adjust the print quality.

Note:
You may need to align the print head if your environment or paper type changes after aligning it.

1. Load A4-size plain paper in the paper cassette.

2. Select Maintenance on the home screen.

To select an item, move the focus to the item using the u d l r buttons, and then press the OK button.

3. Select Print Quality Adjustment.

4. Follow the on-screen instructions to check the printer to improve print quality.

If a message is displayed recommending that you clean the print head, perform print head cleaning.

5. Follow the on-screen instructions to print the patterns for print head alignment, and then align the print head.

❏ This pattern allows you to perform alignment if your printouts look blurry.
Find and select the number for the most solid pattern.

❏ This pattern allows you to perform alignment if vertical ruled lines appear misaligned.
Find and select the number for the pattern that has the least misaligned vertical line.
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❏ This pattern allows you to perform alignment if you see horizontal banding at regular intervals.
Find and select the number for the least separated and overlapping pattern.

Related Information

& “Loading Paper in the Paper Cassette” on page 23

Printout is Scuffed or Color is Missing
If you have not used the printer for a long time, the print head nozzles may be clogged and ink drops may not be
discharged. Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

Related Information

& “Checking and Cleaning the Print Head” on page 79

Banding Appears

The print head nozzles may be clogged. Perform a nozzle check to check if the print head nozzles are clogged.
Clean the print head if any of the print head nozzles are clogged.

Related Information

& “Checking and Cleaning the Print Head” on page 79
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Colored Banding Appears at Intervals of Approximately 3.3 cm

❏ Select the appropriate paper type setting for the type of paper loaded in the printer.

❏ Align the print head using the Print Quality Adjustment feature.

❏ When printing on plain paper, print using a higher quality setting.

Related Information

& “List of Paper Type” on page 28
& “Adjusting the Print Quality” on page 99

Blurry Prints, Vertical Banding, or Misalignment

Align the print head using the Print Quality Adjustment feature.

Related Information

& “Adjusting the Print Quality” on page 99

Print Quality Does Not Improve Even After Aligning the Print Head

During bidirectional (or high speed) printing, the print head prints while moving in both directions, and vertical
lines may be misaligned. If print quality does not improve, disable the bidirectional (or high speed) setting.
Disabling this setting may slow down printing speed.

❏ Windows
Clear High Speed on the printer driver’s More Options tab.
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❏ Mac OS

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select Off as the High Speed Printing
setting.

Print Quality is Poor
Check the following if the print quality is poor due to blurry prints, banding, missing colors, faded colors, and
misalignment in the prints.

Checking the printer

Use the Print Quality Adjustment feature.

❏ Perform a nozzle check, and then clean the print head if any of the print head nozzles are clogged.

❏ Align the print head.

Checking the paper

❏ Use paper supported by this printer.

❏ Do not print on paper that is damp, damaged, or too old.

❏ If the paper is curled or the envelope is puffed up, flatten it.

❏ Do not stack the paper immediately after printing.

❏ Dry the printouts completely before filing or displaying them. When drying the printouts, avoid direct sun light,
do not use a dryer, and do not touch the printed side of paper.

❏ When printing images or photos, Epson recommends using genuine Epson paper rather than plain paper. Print
on the printable side of the genuine Epson paper.

Checking the print settings

❏ Select the appropriate paper type setting for the type of paper loaded in the printer.

❏ Print using a higher quality setting.

Checking the ink supply unit

❏ Try to use genuine Epson ink supply units. This product is designed to adjust colors based on the use of genuine
Epson ink supply units. The use of non-genuine ink supply units may cause print quality to decline.

❏ Epson recommends using the ink supply unit before the date printed on the package.

Related Information

& “Adjusting the Print Quality” on page 99
& “Available Paper and Capacities” on page 20
& “List of Paper Type” on page 28
& “Paper Handling Precautions” on page 22
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Paper Is Smeared or Scuffed
❏ When horizontal banding appears or the top or bottom of the paper is smeared, load paper in the correct

direction and slide the edge guides to the edges of the paper.

❏ When vertical banding appears or the paper is smeared, clean the paper path.

❏ Place the paper on a flat surface to check if it is curled. If it is, flatten it.

❏ When printing on thick paper, the print head is close to the printing surface and the paper may be scuffed. In
this case, enable the reduce scuff setting. If you enable this setting, print quality may decline or printing may
slow down.

❏ Control panel
Select Settings > General Settings > Printer Settings from the home screen, and then enable Thick Paper.

❏ Windows
Click Extended Settings on the printer driver's Maintenance tab, and then select Thick Paper and
Envelopes.

❏ Mac OS

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as theThick paper and
envelopes setting.

❏ When performing manual 2-sided printing, make sure that the ink is completely dry before reloading the paper.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “Cleaning the Paper Path for Ink Smears” on page 82

Paper is Smeared During Automatic 2-Sided Printing
When using the automatic 2-sided printing feature and printing high density data such as images and graphs, set
the print density to lower and the drying time to longer.
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Related Information

& “Printer Settings” on page 29

Printed Photos are Sticky
You may be printing on the wrong side of the photo paper. Make sure you are printing on the printable side.

When printing on the wrong side of the photo paper, you need to clean the paper path.

Related Information

& “Cleaning the Paper Path for Ink Smears” on page 82

The Position, Size, or Margins of the Printout Are Incorrect
❏ Load paper in the correct direction, and slide the edge guides against the edges of the paper.

❏ Select the appropriate paper size setting.

❏ Adjust the margin setting in the application so that it falls within the printable area.

Related Information

& “Loading Paper in the Paper Cassette” on page 23
& “Loading Paper in the Paper Feed Slot” on page 25
& “Printable Area” on page 109

Printed Characters Are Incorrect or Garbled
❏ Connect the USB cable securely to the printer and the computer.

❏ If there are any paused print jobs, printed characters may be corrupted.

❏ Do not put the computer manually into the Hibernate mode or the Sleep mode while printing. Pages of garbled
text may be printed next time you start the computer.

❏ If you use the printer driver you had previously used, printed characters may be garbled. Make sure that the
printer driver you are using is for this printer. Check the printer name on the top of the printer driver window.

The Printed Image Is Inverted
Clear any mirror image settings in the printer driver or the application.

❏ Windows
Clear Mirror Image on the printer driver's More Options tab.

❏ Mac OS
Clear Mirror Image from the print dialog's Print Settings menu.
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Mosaic-Like Patterns in the Prints
When printing images or photos, print using high-resolution data. Images on websites are often low resolution
although they look good enough on the display, and so print quality may decline.

Unintentionally Printing on 2-Sides
Clear any 2-sided printing settings in the printer driver.

❏ Windows
Select Off from 2-Sided Printing on the printer driver's Main tab.

❏ Mac OS
Select Off from Two-sided Printing on the print dialog's Two-sided Printing Settings menu.

The Printout Problem Could Not be Cleared
If you have tried all of the solutions and have not solved the problem, try uninstalling and then reinstalling the
printer driver.

Related Information

& “Uninstalling Applications” on page 88
& “Installing the Latest Applications” on page 85

Other Printing Problems

Printing Is Too Slow
❏ Close any unnecessary applications.

❏ Lower the quality setting. High quality printing slows down the printing speed.

❏ Enable the bidirectional (or high speed) setting. When this setting is enabled, the print head prints while
moving in both directions, and the printing speed increases.

❏ Windows
Select High Speed on the printer driver's More Options tab.

❏ Mac OS

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select On as the High Speed
Printing setting.
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❏ Disable quiet mode. This feature slows down the printing speed.

❏ Control Panel

Select  on the home screen, and then disable Quiet Mode.

❏ Windows
Select Off as the Quiet Mode setting on the printer driver's Main tab.

❏ Mac OS

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and
then select the printer. Click Options & Supplies > Options (or Driver). Select Off as the Quiet Mode
setting.

❏ For 2-sided printing, one side of paper is printed and dried, and then the other side is printed. Because the
drying time differs depending on the environment, such as temperature or humidity, or the print data, the
printing speed may be slower.

Printing Slows Down Dramatically During Continuous Printing
Printing slows down to prevent the printer mechanism from overheating and being damaged. However, you can
continue printing. To return to normal printing speed, leave the printer idle for at least 30 minutes. Printing speed
does not return to normal if the power is off.

Envelope is Wrinkled
Envelopes may be wrinkled when feeding them from the paper feed slot. In this case, load envelopes in the paper
cassette. See the related information link below for available sizes and loading capacity.

Related Information

& “Available Paper and Capacities” on page 20

Cannot Cancel Printing from a Computer Running Mac OS X v10.6.8
If you want to stop printing from your computer, make the following settings.

Run Web Config, and then select Port9100 as the Top Priority Protocol setting in AirPrint Setup. Select System
Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), remove the printer, and
then add the printer again.

PostScript Printer Driver Problems
Note:
The menu items and text on the printer driver vary depending on your computer's environment.
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Printer Does Not Print While Using PostScript Printer Driver
❏ Set the Printing Language setting to Auto or PS3 on the control panel.

❏ In Windows, if a large number of jobs are sent, the printer may not print. Select Print directly to the printer on
the Advanced tab in the printer properties.

Related Information

& “Printer Settings” on page 29

Printer Does Not Print Correctly While Using PostScript Printer
Driver
❏ If the file is created in an application that allows you to change the data format, such as Adobe Photoshop, make

sure that the settings in the application match the settings in the printer driver.

❏ EPS files made in binary format may not be printed correctly. Set the format to ASCII when making EPS files in
an application.

❏ For Windows, the printer cannot print binary data when it is connected to the computer using a USB interface.
Set the Output Protocol setting on the Device Settings tab in the printer properties to ASCII or TBCP.

❏ For Windows, select the appropriate substitution fonts on the Device Settings tab in the printer properties.

Printing Is Too Slow While Using PostScript Printer Driver
Set the Print Quality setting to Fast in the printer driver.

Other Problems

Slight Electric Shock when Touching the Printer
If many peripherals are connected to the computer, you may feel a slight electric shock when touching the printer.
Install a ground wire to the computer that is connected to the printer.

Operation Sounds Are Loud
If operations sounds are too loud, enable Quiet Mode. Enabling this feature may reduce printing speed.

❏ Control panel

Select  on the home screen, and then enable Quiet Mode.

❏ Windows printer driver
Enable Quiet Mode on the Main tab.
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❏ Mac OS printer driver

Select System Preferences from the  menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer. Click Options & Supplies > Options (or Driver). Select On as the Quiet Mode setting.

Forgot Your Password
If you forget the administrator's password, contact Epson support.

Related Information

& “Contacting Epson Support” on page 125

Application Is Blocked by a Firewall (for Windows Only)
Add the application to the Windows Firewall allowed program in security settings on the Control Panel.
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Appendix

Technical Specifications

Printer Specifications

Print Head Nozzle Placement Black ink nozzles: 1600

Weight of Paper * Plain Paper 64 to 90 g/m2(17 to 24lb)

Thick Paper 91 to 180 g/m2 (25 to 48 lb)

Envelopes Envelope #10, DL, C6: 75 to 90 g/m2 (20 to 24 lb)

Envelope C4: 80 to 100 g/m2 (21 to 26 lb)

* Even when the paper thickness is within this range, the paper may not feed in the printer or print result may adversely
affected depending on the paper property or quality.

Printable Area

Print quality may decline in the shaded areas due to the printer's mechanism.

Single sheets

A 3.0 mm (0.12 in.)

B 3.0 mm (0.12 in.)

C 47.0 mm (1.85 in.)

D 45.0 mm (1.77 in.)

Envelopes

A 3.0 mm (0.12 in.)

B Except for C4:

5.0 mm (0.20 in.)

C4:

9.5 mm (0.37 in.)

C 18.0 mm (0.71 in.)

D 47.0 mm (1.85 in.)
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Interface Specifications

For Computer Hi-Speed USB

Network Function List

Network Functions and IPv4/IPv6

Functions Supported Remarks

Network Printing EpsonNet Print (Windows) IPv4 ✓ -

Standard TCP/IP (Windows) IPv4, IPv6 ✓ -

WSD Printing (Windows) IPv4, IPv6 ✓ Windows Vista or
later

Bonjour Printing (Mac OS) IPv4, IPv6 ✓ -

IPP Printing (Windows, Mac
OS)

IPv4, IPv6 ✓ -

UPnP Printing IPv4 - Information
appliance

PictBridge Printing (Wi-Fi) IPv4 - Digital camera

Epson Connect (Email Print,
Remote Print)

IPv4 ✓ -

AirPrint (iOS, Mac OS) IPv4, IPv6 ✓ iOS 5 or later, Mac
OS X v10.7 or later

Google Cloud Print IPv4, IPv6 ✓ -

Network Scanning Epson Scan 2 IPv4, IPv6 - -

Event Manager IPv4 - -

Epson Connect (Scan to
Cloud)

IPv4 - -

AirPrint (Scan) IPv4, IPv6 - -

ADF (2-sided scanning) - -

Fax Send a fax IPv4 - -

Receive a fax IPv4 - -

AirPrint (Faxout) IPv4, IPv6 - -

Wi-Fi Specifications

Standards IEEE802.11b/g/n*1
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Frequency Range 2.4 GHz

Maximum Radio-Frequency
Power Transmitted

20 dBm (EIRP)

Coordination Modes Infrastructure, Wi-Fi Direct (Simple AP)*2

Wireless Securities*3 WEP (64/128bit), WPA2-PSK (AES)*4, WPA2-Enterprise (AES)

*1 IEEE802.11n is only available for the HT20.

*2 Not supported for IEEE 802.11b.

*3 Wi-Fi Direct supports WPA2-PSK (AES) only.

*4 Complies with WPA2 standards with support for WPA/WPA2 Personal.

Ethernet Specifications

Standards IEEE802.3i (10BASE-T)*1

IEEE802.3u (100BASE-TX)

IEEE802.3ab (1000BASE-T)*1

IEEE802.3az (Energy Efficient Ethernet)*2

Communication Mode Auto, 10Mbps Full duplex, 10Mbps Half duplex, 100Mbps Full duplex, 100Mbps
Half duplex

Connector RJ-45

*1 Use a category 5e or higher STP (Shielded twisted pair) cable to prevent risk of radio interference.

*2 The connected device should comply with IEEE802.3az standards.

Security Protocol

IEEE802.1X*

IPsec/IP Filtering

SSL/TLS HTTPS Server/Client

IPPS

SMTPS (STARTTLS, SSL/TLS)

SNMPv3

* You need to use a device for connection that complies with IEEE802.1X.

PostScript Level 3 Compatibility
The PostScript used on this printer is compatible with PostScript Level 3.
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Supported Third Party Services

AirPrint Print iOS 5 or later/Mac OS X v10.7.x or later

Google Cloud Print

Dimensions

Dimensions Storage

❏ Width: 425 mm (16.7 in.)

❏ Depth*1: 508 mm (20.0 in.)

❏ Height: 290 mm (11.4in.)

Printing

❏ Width: 425 mm (16.7 in.)

❏ Depth: 508 mm (20.0 in.)

❏ Height: 290 mm (11.4in.)

Weight* Approx. 14.0 kg (30.9 lb)

*1 With the output tray installed.

*2 Without the ink supply unit and the power cord.

Electrical Specifications

Model 100 to 240 V Model 220 to 240 V Model

Rated Frequency Range 50 to 60 Hz 50 to 60 Hz

Rated Current 0.6 to 0.3 A 0.3 A

Power Consumption (with USB Con-
nection)

Printing: Approx. 22 W (ISO/IEC24712)

Ready mode: Approx. 8 W

Sleep mode: Approx. 1.2 W

Power off: Approx. 0.2 W

Printing: Approx. 22 W (ISO/IEC24712)

Ready mode: Approx. 8 W

Sleep mode: Approx. 1.2 W

Power off: Approx. 0.2 W

Note:
❏ Check the label on the printer for its voltage.

❏ For European users, see the following Website for details on power consumption.
http://www.epson.eu/energy-consumption
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Environmental Specifications

Operation Use the printer within the range shown in the following graph.

Temperature: 10 to 35°C (50 to 95°F)

Humidity: 20 to 80% RH (without condensation)

Storage Temperature: -20 to 40°C (-4 to 104°F)*

Humidity: 5 to 85% RH (without condensation)

* You can store for one month at 40°C (104°F).

Environmental Specifications for Ink Supply Units

Storage Temperature -30 to 40 °C (-22 to 104 °F)*

Freezing Temperature -13 °C (8.6 °F)

Ink thaws and is usable after approximately 5 hours at 25 °C (77 °F).

* You can store for one month at 40 °C (104 °F).

System Requirements
❏ Windows 10 (32-bit, 64-bit)/Windows 8.1 (32-bit, 64-bit)/Windows 8 (32-bit, 64-bit)/Windows 7 (32-bit, 64-

bit)/Windows Vista (32-bit, 64-bit)/Windows XP SP3 or later (32-bit)/Windows XP Professional x64 Edition SP2
or later/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012/Windows Server 2008 R2/
Windows Server 2008/Windows Server 2003 R2/Windows Server 2003 SP2 or later

❏ macOS High Sierra/macOS Sierra/OS X El Capitan/OS X Yosemite/OS X Mavericks/OS X Mountain Lion/Mac
OS X v10.7.x/Mac OS X v10.6.8

Note:
❏ Mac OS may not support some applications and features.

❏ The UNIX File System (UFS) for Mac OS is not supported.
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Font Information

Available Fonts for PostScript

Font Name Family HP Equivalent

Nimbus Mono Medium, Bold, Italic, Bold Italic Courier

Letter Gothic Medium, Bold, Italic Letter Gothic

Nimbus Mono PS Regular, Bold, Oblique, Bold Oblique CourierPS

Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CG Times

URW Classico Medium, Bold, Italic, Bold Italic CG Omega

URW Coronet - Coronet

URW Clarendon Condensed - Clarendon Condensed

URW Classic Sans Medium, Bold, Italic, Bold Italic Univers

URW Classic Sans Condensed Medium, Bold, Italic, Bold Italic Univers Condensed

Antique Olive Medium, Bold, Italic Antique Olive

Garamond Antiqua, Halbfett, Kursiv, Kursiv Halbfett Garamond

Mauritius - Marigold

Algiers Medium, Extra Bold Albertus

NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial

Nimbus Roman No9 Medium, Bold, Italic, Bold Italic Times New Roman

Nimbus Sans Medium, Bold, Oblique, Bold Oblique Helvetica

Nimbus Sans Narrow Medium, Bold, Oblique, Bold Oblique Helvetica Narrow

Palladio Roman, Bold, Italic, Bold Italic Palatino

URW Gothic Book, Demi, Book Oblique, Demi Oblique ITC Avant Garde

URW Bookman Light, Demi, Light Italic, Demi Italic ITC Bookman

URW Century Schoolbook Roman, Bold, Italic, Bold Italic New Century Schoolbook

Nimbus Roman Medium, Bold, Italic, Bold Italic Times

URW Chancery Medium Italic - ITC Zapf Chancery Italic

Symbol - Symbol

URW Dingbats - Wingdings

Dingbats - ITC Zapf Dingbats

Standard Symbol - SymbolPS
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Available Fonts for PCL (URW)

Scalable Font

Font Name Family HP Equivalent Symbol
Set for
PCL5

Nimbus Mono Medium, Bold, Italic, Bold Italic Courier 1

Letter Gothic Medium, Bold, Italic Letter Gothic 1

Nimbus Mono PS Regular, Bold, Oblique, Bold Oblique CourierPS 3

Nimbus Roman No4 Medium, Bold, Italic, Bold Italic CG Times 2

URW Classico Medium, Bold, Italic, Bold Italic CG Omega 3

URW Coronet - Coronet 3

URW Clarendon Condensed - Clarendon Condensed 3

URW Classic Sans Medium, Bold, Italic, Bold Italic Univers 2

URW Classic Sans
Condensed

Medium, Bold, Italic, Bold Italic Univers Condensed 3

Antique Olive Medium, Bold, Italic Antique Olive 3

Garamond Antiqua, Halbfett, Kursiv, Kursiv Halbfett Garamond 3

Mauritius - Marigold 3

Algiers Medium, Extra Bold Albertus 3

NimbusSansNo2 Medium, Bold, Italic, Bold Italic Arial 3

Nimbus Roman No9 Medium, Bold, Italic, Bold Italic Times New 3

Nimbus Sans Medium, Bold, Oblique, Bold Oblique Helvetica 3

Nimbus Sans Narrow Medium, Bold, Oblique, Bold Oblique Helvetica Narrow 3

Palladio Roman, Bold, Italic, Bold Italic Palatino 3

URW Gothic Book, Demi, Book Oblique, Demi Oblique ITC Avant Garde Gothic 3

URW Bookman Light, Demi, Light Italic, Demi Italic ITC Bookman 3

URW Century Schoolbook Roman, Bold, Italic, Bold Italic New Century Schoolbook 3

Nimbus Roman Medium, Bold, Italic, Bold Italic Times 3

URW Chancery Medium
Italic

- ITC Zapf Chancery Medium
Italic

3

Symbol - Symbol 4

URW Dingbats - Wingdings 5

Dingbats - ITC Zapf Dingbats 6

Standard Symbol - SymbolPS 4
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Font Name Family HP Equivalent Symbol
Set for
PCL5

URW David Medium, Bold HP David 7

URW Narkis Medium, Bold HP Narkis 7

URW Miryam Medium, Bold, Italic HP Miryam 7

URW Koufi Medium, Bold Koufi 8

URW Naskh Medium, Bold Naskh 8

URW Ryadh Medium, Bold Ryadh 8

Bitmap Font

Font Name Symbol
Set

Line Printer 9

OCR/Barcode Bitmap Font (for PCL5 only)

Font Name Family Symbol
Set

OCR A - 10

OCR B - 11

Code39 9.37cpi, 4.68cpi 12

EAN/UPC Medium, Bold 13

Note:
Depending on the print density, or on the quality or color of the paper, OCR A, OCR B, Code39, and EAN/UPC fonts may
not be readable. Print a sample and make sure the fonts can be read before printing large quantities.

List of Symbol Sets
Your printer can access a variety of symbol sets. Many of these symbol sets differ only in the international
characters specific to each language.

When you are considering which font to use, you should also consider which symbol set to combine with the font.

Note:
Since most software handles fonts and symbols automatically, you will probably never need to adjust the printer's settings.
However, if you are writing your own printer control programs, or if you are using older software that cannot control fonts,
refer to the following sections for symbol set details.

User's Guide

Appendix

116



List of Symbol Sets for PCL 5

Symbol Set
Name

Attribute Font Classification

1 2 3 4 5 6 7 8 9 10 11 12 13

Norweg1 0D ✓ ✓ ✓ - - - - - - - - - -

Roman
Extension

0E - - - - - - - - ✓ - - - -

Italian 0I ✓ ✓ ✓ - - - - - - - - - -

ECM94-1 0N ✓ ✓ ✓ - - - - - ✓ - - - -

Swedis2 0S ✓ ✓ ✓ - - - - - - - - - -

ANSI ASCII 0U ✓ ✓ ✓ - - - ✓ ✓ - - - - -

UK 1E ✓ ✓ ✓ - - - - - - - - - -

French2 1F ✓ ✓ ✓ - - - - - - - - - -

German 1G ✓ ✓ ✓ - - - - - - - - - -

Legal 1U ✓ ✓ ✓ - - - - - ✓ - - - -

8859-2 ISO 2N ✓ ✓ ✓ - - - - - ✓ - - - -

Spanish 2S ✓ ✓ ✓ - - - - - - - - - -

ISO 8859/4
Latin 4

4N ✓ ✓ ✓ - - - - - - - - - -

Roman-9 4U ✓ ✓ ✓ - - - - - - - - - -

PsMath 5M ✓ ✓ ✓ - - - ✓ ✓ - - - - -

8859-9 ISO 5N ✓ ✓ ✓ - - - - - ✓ - - - -

WiTurkish 5T ✓ ✓ ✓ - - - - - - - - - -

MsPublishin 6J ✓ ✓ ✓ - - - - - - - - - -

VeMath 6M ✓ ✓ ✓ - - - - - - - - - -

8859-10ISO 6N ✓ ✓ ✓ - - - - - ✓ - - - -

DeskTop 7J ✓ ✓ ✓ - - - - - - - - - -

Math-8 8M ✓ ✓ ✓ - - - ✓ ✓ - - - - -

Roman-8 8U ✓ ✓ ✓ - - - - - ✓ - - - -

WiE.Europe 9E ✓ ✓ ✓ - - - - - - - - - -

Pc1004 9J ✓ ✓ ✓ - - - - - - - - - -

8859-15ISO 9N ✓ ✓ ✓ - - - - - ✓ - - - -

PcTk437 9T ✓ ✓ ✓ - - - - - - - - - -

Windows 9U ✓ ✓ ✓ - - - - - - - - - -
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Symbol Set
Name

Attribute Font Classification

1 2 3 4 5 6 7 8 9 10 11 12 13

PsText 10J ✓ ✓ ✓ - - - - - - - - - -

IBM-US 10U ✓ ✓ ✓ - - - - - ✓ - - - -

IBM-DN 11U ✓ ✓ ✓ - - - - - ✓ - - - -

McText 12J ✓ ✓ ✓ - - - - - - - - - -

PcMultiling 12U ✓ ✓ ✓ - - - - - ✓ - - - -

VeInternati 13J ✓ ✓ ✓ - - - - - - - - - -

PcEur858 13U ✓ ✓ ✓ - - - - - - - - - -

VeUS 14J ✓ ✓ ✓ - - - - - - - - - -

PiFont 15U ✓ ✓ ✓ - - - - - - - - - -

PcE.Europe 17U ✓ ✓ ✓ - - - - - - - - - -

Unicode 3.0 18N ✓ ✓ ✓ - - - ✓ ✓ - - - - -

WiBALT 19L ✓ ✓ ✓ - - - - - - - - - -

WiAnsi 19U ✓ ✓ ✓ - - - - - - - - - -

PcBlt775 26U ✓ ✓ ✓ - - - - - - - - - -

Pc866Cyr 3R ✓ ✓ - - - - - - - - - - -

Greek8 8G ✓ ✓ - - - - - - - - - - -

WinGrk 9G ✓ ✓ - - - - - - - - - - -

WinCyr 9R ✓ ✓ - - - - - - - - - - -

Pc851Grk 10G ✓ ✓ - - - - - - - - - - -

ISOCyr 10N ✓ ✓ - - - - - - ✓ - - - -

Pc8Grk 12G ✓ ✓ - - - - - - - - - - -

ISOGrk 12N ✓ ✓ - - - - - - - - - - -

Pc866Ukr 14R ✓ ✓ - - - - - - - - - - -

Hebrew7 0H ✓ - - - - - ✓ - - - - - -

8859-8 ISO 7H ✓ - - - - - ✓ - - - - - -

Hebrew8 8H ✓ - - - - - ✓ - - - - - -

Pc862Heb 15H ✓ - - - - - ✓ - - - - - -

PC-862,
Hebrew

15Q ✓ - - - - - ✓ - - - - - -

Arabic8 8V - - - - - - - ✓ - - - - -

HPWARA 9V - - - - - - - ✓ - - - - -
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Symbol Set
Name

Attribute Font Classification

1 2 3 4 5 6 7 8 9 10 11 12 13

Pc864Ara 10V - - - - - - - ✓ - - - - -

Symbol 19M - - - ✓ - - - - - - - - -

Wingdings 579L - - - - ✓ - - - - - - - -

ZapfDigbats 14L - - - - - ✓ - - - - - - -

OCR A 0O - - - - - - - - - ✓ - - -

OCR B 1O - - - - - - - - - - ✓ - -

OCR B
Extension

3Q - - - - - - - - - - ✓ - -

Code3-9 0Y - - - - - - - - - - - ✓ -

EAN/UPC 8Y - - - - - - - - - - - - ✓

Regulatory Information

Standards and Approvals for European Model
For European users

Hereby, Seiko Epson Corporation declares that the following radio equipment model is in compliance with
Directive 2014/53/EU. The full text of the EU declaration of conformity is available at the following website.

http://www.epson.eu/conformity

B652B

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece,
Slovenia, Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-
recommended modification of the products.

German Blue Angel
See the following website to check whether or not this printer meets the standards for the German Blue Angel.

http://www.epson.de/blauerengel
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Restrictions on Copying
Observe the following restrictions to ensure the responsible and legal use of the printer.

Copying of the following items is prohibited by law:

❏ Bank bills, coins, government-issued marketable securities, government bond securities, and municipal
securities

❏ Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

❏ Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

❏ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

❏ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:

Printers can be misused by improperly copying copyrighted materials. Unless acting on the advice of a
knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Transporting the Printer
When you need to transport the printer to move or for repairs, follow the steps below to pack the printer.

!Caution:

❏ When carrying the printer, lift it using a stable position. Lifting the printer using an unstable position may result
in injury.

❏ Because this printer is heavy, it should always be carried by two or more people when unpacking and
transporting.

❏ When lifting the printer, place your hands in the positions shown below. If you lift the printer holding other
positions, the printer may fall or you may trap your fingers when placing the printer.

❏ When carrying the printer, do not tilt it more than 10 degrees; otherwise the printer may fall.
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c
Important:

❏ When storing or transporting the printer, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

❏ Leave the ink supply units installed. Removing the ink supply units can dry out the print head and may prevent
the printer from printing.

1. Turn off the printer by pressing the P button.

2. Make sure the power light turns off, and then unplug the power cord.

c
Important:

Unplug the power cord when the power light is off. Otherwise, the print head does not return to the home
position causing the ink to dry, and printing may become impossible.

3. Disconnect all cables such as the power cord and USB cable.

4. If the printer supports external storage devices, make sure they are not connected.

5. Remove all of the paper from the printer.

6. Open the printer cover. Secure the print head to the case with tape.
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7. Close the printer cover.

8. Prepare to pack the printer as shown below.

9. Remove the output tray from the printer.

10. Pack the printer in its box, using the protective materials.

When you use the printer again, make sure you remove the tape securing the print head. If print quality has
declined the next time you print, clean and align the print head.

Related Information

& “Part Names and Functions” on page 13
& “Checking and Cleaning the Print Head” on page 79
& “Aligning the Print Head” on page 80
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Copyright
No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of
Seiko Epson Corporation. No patent liability is assumed with respect to the use of the information contained
herein. Neither is any liability assumed for damages resulting from the use of the information herein. The
information contained herein is designed only for use with this Epson product. Epson is not responsible for any
use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or
abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.)
failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko
Epson Corporation.

© 2018 Seiko Epson Corporation

The contents of this manual and the specifications of this product are subject to change without notice.

Trademarks
❏ EPSON® is a registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a

trademark of Seiko Epson Corporation.

❏ The N-Mark is a trademark or registered trademark of NFC Forum, Inc. in the United States and in other
countries.

❏ QR Code is a registered trademark of DENSO WAVE INCORPORATED in Japan and other countries.

❏ Microsoft®, Windows®, Windows Server®, and Windows Vista® are registered trademarks of Microsoft
Corporation.

❏ Apple, Macintosh, macOS, OS X, Bonjour, ColorSync, Safari, AirPrint, the AirPrint Logo, iPad, iPhone, iPod
touch, and iTunes are trademarks of Apple Inc., registered in the U.S. and other countries.

❏ Google Cloud Print, Chrome, Chrome OS, Google Play and Android are trademarks of Google Inc.

❏ Adobe, the Adobe logo, Acrobat, Photoshop, PostScript®3™, and Reader are either registered trademarks or
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

❏ Albertus, Arial, Coronet, Gill Sans, Joanna and Times New Roman are trademarks of The Monotype
Corporation registered in the United States Patent and Trademark Office and may be registered in certain
jurisdictions.

❏ ITC Avant Garde Gothic, ITC Bookman, Lubalin Graph, Mona Lisa, ITC Symbol, Zapf Chancery and Zapf
Dingbats are trademarks of International Typeface Corporation registered in the U.S. Patent and Trademark
Office and may be registered in certain other jurisdictions.

❏ Clarendon, Eurostile and New Century Schoolbook are trademarks of Linotype GmbH registered in the U.S.
Patent and Trademark Office and may be registered in certain other jurisdictions.

❏ Wingdings is a registered trademark of Microsoft Corporation in the United States and other countries.
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❏ CG Omega, CG Times, Garamond Antiqua, Garamond Halbfett, Garamond Kursiv, Garamond Halbfett Kursiv
are trademarks of Monotype Imaging, Inc. and may be registered in certain jurisdictions.

❏ Antique Olive is a trademark of M. Olive.

❏ Marigold and Oxford are trademarks of AlphaOmega Typography.

❏ Helvetica, Optima, Palatino, Times and Univers are trademarks of Linotype Corp. registered in the U.S. Patent
and Trademark Office and may be registered in certain other jurisdictions in the name of Linotype Corp. or its
licensee Linotype GmbH.

❏ PCL is the registered trademark of Hewlett-Packard Company.

❏ Arcfour
This code illustrates a sample implementation of the Arcfour algorithm.
Copyright © April 29, 1997 Kalle Kaukonen. All Rights Reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that
this copyright notice and disclaimer are retained.
THIS SOFTWARE IS PROVIDED BY KALLE KAUKONEN AND CONTRIBUTORS ''AS IS'' AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL KALLE KAUKONEN OR CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

❏ microSDHC Logo is a trademark of SD-3C, LLC.
Note: microSDHC is built into the product and cannot be removed.

❏ General Notice: Other product names used herein are for identification purposes only and may be trademarks
of their respective owners. Epson disclaims any and all rights in those marks.

Where to Get Help

Technical Support Web Site
If you need further help, visit the Epson support website shown below. Select your country or region and go to the
support section of your local Epson website. The latest drivers, FAQs, manuals, or other downloadables are also
available from the site.

http://support.epson.net/

http://www.epson.eu/Support (Europe)

If your Epson product is not operating properly and you cannot solve the problem, contact Epson support services
for assistance.
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Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product manuals, contact Epson support services for assistance. If Epson support for your area
is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

❏ Product serial number
(The serial number label is usually on the back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or a similar button in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and version

❏ Names and versions of the software applications you normally use with your product

Note:
Depending on the product, network settings may be stored in the product’s memory. Due to breakdown or repair of a
product, settings may be lost. Epson shall not be responsible for the loss of any data, for backing up or recovering settings
even during a warranty period. We recommend that you make your own backup data or take notes.

Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.
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